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REGISTER THIS BOOK, THEN DOWNLOAD 
PHOTOS FOR FREE!
Purchasing this book entitles you to more than just a couple 
of pounds of paper. If you register the book with Peachpit 
Press, you will also be entitled to download copies of many 
of the images that are used throughout the book, which 
you can use to practice with as you follow our step-by-step 
tutorials. 

To access the bonus images, log in to your Peachpit account 
or create one at Peachpit.com/join (it’s free). On your 
Account page (under the Registered Products tab), click 
Register Your Products Here or Register Another Product,
enter the ISBN number for this book: 0133980464, then 
click Submit. Finally, below the title of this book, click the 
Access Bonus Content link.

Note: The downloadable images that we have made available 
are low resolution (not suitable for printing), and they are 
copyrighted by their owners, who have watermarked them 
to discourage unauthorized reproduction. They are for your 
personal use only—not for distribution or publication.

A NOTE REGARDING THE CONTENT OF THIS BOOK
Before going to press with this book, we tested (and 
retested) our text to ensure that it accurately describes the 
options and features we viewed in the prerelease version of 
Photoshop. Due to the nature of Creative Cloud subscrip-
tions, however, some features may change or be updated at 
a later date. 

KEEPING YOUR COPY OF PHOTOSHOP UP-TO-DATE
As a subscriber to Creative Cloud, you will be able to access 
updates to Photoshop (and any other Adobe Creative Cloud 
programs you have installed) as soon as they are released 
by Adobe. To access updates, and to manage assets (files 
and fonts) stored in the Cloud, click the Creative Cloud icon 
in the Taskbar (in Windows) or on the menu bar (in the 
Mac OS) to open the application. Click the Apps panel, then 
click Update for Photoshop (or any other program). It’s that 
simple. Note: In the Mac OS, when updates are available, the 
Creative Cloud icon will turn blue and a number will display 
by its side to signify how many of your installed programs 
have updates.
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Using the powerful and wide-ranging 
controls in the Adobe Camera Raw plug-in,
you can apply corrections to your photos 
before opening them into Photoshop. In this 
comprehensive chapter, you’ll learn about the Camera 
Raw tools and tabs; choose workflow options for 
Camera Raw; apply cropping and straightening; and 
correct photos for defects, such as poor contrast, under- 
or overexposure, color casts, blurriness, geometric distor-
tion, and noise. You will also learn how to enhance your 
photos with special effects, such as a vignette, grain 
texture, or tint; retouch blemishes; access Camera Raw 
controls from Photoshop; save and synchronize Camera 
Raw settings among related photos; then finally, open 
your corrected photos into Photoshop.

Note: The Camera Raw plug-in, which we refer to simply 
as “Camera Raw,” is included with Photoshop. Some 
users also refer to the plug-in as “ACR,” short for Adobe 
Camera Raw.

Why use Camera Raw?
Amateur-level digital cameras store images in the JPEG 
or TIFF format, whereas advanced amateur and pro 
models offer the option to save images as raw data files, 
which offers substantial advantages. Cameras apply 
internal processing to photos that are captured as JPEG 
or TIFF, such as sharpening, automatic color adjustments, 
and a white balance setting. With raw files, you get only 
the original raw information that the lens captured onto 
the camera’s digital sensor, leaving you with full control 
over subsequent image processing and correction.

These are some basic facts about Camera Raw:

➤ Camera Raw can process raw, TIFF, and JPEG photos 
from most digital camera models.

➤ Camera Raw offers powerful controls for correcting 
problems in your photos, such as over- and under-
exposure and color casts, and for applying enhance-
ments, such as a vignette or a grain texture.

➤ Camera Raw saves edits to TIFF and JPEG files in 
the file itself, whereas edits to raw files are saved 
as instructions (in a separate “sidecar” file or in the 
Camera Raw database). When you open a photo 
from Camera Raw into Photoshop, the instructions 
are applied to a copy of the file, and the original raw 
file is preserved.

➤ To any image layer in Photoshop, you can apply 
some Camera Raw features via the Filter > Camera 
Raw Filter command.
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CAPTURING TONAL VALUES: YOUR CAMERA VERSUS THE HUMAN EYE

A The digital sensor in a camera captures tonal values 
in a linear fashion, from light to dark, without altering 
the incoming data. A light value of 50% is located at the 
midpoint of the tonal range.

50% light value

B Camera Raw redistributes some of the captured tonal 
values to the shadows and midtones, shifting the 50% 
light value past the midpoint. As a result, the lower tonal 
values — the range the human eye tends to be more 
sensitive to — contain more data.

50% light value

More reasons to use Camera Raw

In case you’re not fully sold on the benefits of cor-
recting your digital photos in Camera Raw before 
opening them into Photoshop, consider these points: 

Ability to preview raw files: The only way to preview 
a raw photo is in Camera Raw (or other software that 
converts raw files). Note: The photo that you view 
on the LCD screen of your digital camera is merely a 
JPEG preview of the raw capture, not the “actual” raw 
capture.

Great correction features: Camera Raw offers many 
unique adjustment controls that you simply won’t 
find in Photoshop. 

Less destructive edits: When applying corrections to 
a photo, the goal is to preserve as much of the image 
quality as possible. Adjustments that you make to a 
photo in Camera Raw (and that are applied automat-
ically when the photo is opened in Photoshop) cause 
less data loss than similar adjustment commands in 
Photoshop. 

Preserves 16 bits per channel: To preserve more of 
the original pixel data in a raw photo, Camera Raw 
keeps the bit depth as 16 bits per channel. This helps 
offset the data loss from subsequent image edits in 
Photoshop, and results in a better-quality photo.

Tonal redistribution: The sensor in a digital camera 
captures and records the existing range of tonal 
values in a scene as is, in a linear fashion, without 
skewing the data toward a particular tonal range.A
That sounds fine on paper, but the reality is that the 
human eye is more sensitive to lower light levels 

than to higher light levels. In other words, we’re 
more likely to notice if shadow areas lack detail and 
less likely to notice extra details in highlight areas. 
The result is that digital photos typically contain 
more data than necessary for the highlight values in 
a scene and insufficient data for the lower midtone 
and shadow values. In a Camera Raw conversion, 
data is shifted more into the midtone and shadow 
ranges of your photo. This not only helps compen-
sate for the peculiarities of human vision, but also 
helps prepare your photos for subsequent image 
edits in Photoshop.B If you apply tonal adjustments 
in Photoshop to a photo that contains insufficient 
shadow data, the result is posterization and a notice-
able loss of detail; if you apply the same edits to 
a good-quality photo that has been converted in 
Camera Raw, the destructive edits will be far less 
noticeable.

Superior noise reduction and sharpening: Not 
to knock Photoshop, but the noise reduction and 
sharpening features in Camera Raw cause less data 
loss than similar features in Photoshop.

Learning the Camera Raw features will give you a 
head start: The tonal and color controls in Camera 
Raw are similar to many of the adjustment con-
trols in Photoshop (e.g., Levels, Curves, and Hue/
Saturation) that are discussed in later chapters. As 
you proceed through the lessons in this book, you 
will apply and build on the skills you have mastered 
in this chapter. 
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Raw, JPEG, or TIFF?

Unfortunately, Camera Raw can’t correct deficiencies 
in digital JPEG and TIFF photos as fully as it can in 
raw photos, for several reasons. First, cameras reduce 
digital JPEG and TIFF photos to a bit depth of 8 bits 
per channel, and in so doing discard some of the 
captured pixels. Cameras save raw photos at a bit 
depth of 16 bits per channel, and preserve all the 
captured pixels. 

Second, cameras apply color and tonal corrections 
to JPEGs and TIFFs (called “in-camera” processing). 
Camera Raw must reinterpret this processed data, 
with less successful results than when it has access 
to the raw, unprocessed data. 

All of the above notwithstanding, if your camera 
doesn’t shoot raw photos or you acquire JPEG or TIFF 
photos from other sources, you can still use practi-
cally all of the outstanding correction and adjust-
ment features in Camera Raw to process them. 

Note: In this chapter, we focus only on processing 
raw and JPEG files in Camera Raw — not TIFF files. 
The JPEG format is mentioned only when a particular 
feature treats a JPEG differently than a raw file.

➤ Factoid: Each digital camera manufacturer cre-
ates its own version of a raw file and attaches a 
different extension to the names of its raw files, 
such as .nef for Nikon and .crw or .cr2 for Canon.

JPEG …
JPEG advantages
➤ JPEG files have a smaller storage size than raw 
files, so your digital camera can store more of them. 

➤ In sports, nature, and other fast-action photog-
raphy, speed is a necessity. Photo sequences can 
be captured more rapidly as JPEG files (due to their 
smaller storage size) than raw files. 

➤ Most software programs can read JPEG files, but 
only a few programs can read raw files.

JPEG drawbacks
➤ The JPEG format discards some captured pixels 
due to its lower bit depth of 8 bits per channel.

➤ The JPEG compression methods destroy some 
image data and can produce defects, such as arti-
facts, banding, and loss of detail. 

➤ The pixel data in JPEG photos is processed inter-
nally by the camera. Although Camera Raw can be 
used to improve your JPEG photos, it won’t have 
access to the original pixel data (nor will you).

… COMPARED TO RAW
Raw advantages
➤ The raw compression methods are nondestructive. 

➤ Raw files have a higher bit depth of 16 bits per 
channel.

➤ Raw files contain the original, unprocessed pixel 
data and full range of tonal levels that were cap-
tured by the camera. Camera Raw is given all that 
image data to work with, and the result is a higher-
quality image — even after adjustments.

➤ Because the white point setting isn’t applied to 
your raw photo (it’s merely stored in the metadata 
of the file), you can adjust that setting at any time in 
Camera Raw. 

➤ Camera Raw does a better job of redistributing 
tonal values in raw files than in JPEG files, making 
raw files better candidates for Photoshop edits.

Raw drawbacks
➤ Raw files have larger storage sizes than JPEG files.

➤ Digital cameras create and store raw files more 
slowly than JPEG files, a potential drawback in 
fast-action photography (although as camera tech-
nology improves, this may become less of an issue).

The bottom line
Despite the faster speed and smaller storage sizes of 
JPEG files, raw files have more advantages.

KEEPING CAMERA RAW UP TO DATE
Of the many proprietary raw “formats” in the 
universe, some are unique to each manufacturer 
(such as Nikon or Canon) and some are unique to 
each camera model. To ensure that Camera Raw is 
using the latest interpreter for your camera, visit 
www.adobe.com periodically, and download and 
install any Camera Raw updates that are posted for 
your camera model.

http://www.adobe.com
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RECOGNIZING THE BADGE
In Bridge, the thumbnail for a file that has been 
opened and edited previously in Camera Raw will 
display this badge  in the upper-right corner, and 
the thumbnail and preview will reflect the current 
settings. Another clue: If the currently selected file 
has been edited in Camera Raw, you will see a Camera 
Raw category in the Metadata panel.

Opening photos into Camera Raw
For a smooth workflow, we recommend setting the 
proper preferences so your raw photos (and JPEG or 
TIFF photos, if any) will open directly into Camera Raw.

To set a preference so your raw photos 
open directly into Camera Raw:

1. In Photoshop, go to Edit/Photoshop > Preferences 
(Ctrl-K/Cmd-K) > File Handling.

2. Under File Compatibility, check Prefer Adobe 
Camera Raw for Supported Raw Files, then click 
OK. When you double-click a raw file, it will open 
into Camera Raw (as opposed to other software 
that can be used to convert raw files).

To set a preference so your JPEG or TIFF 
photos open directly into Camera Raw:

1. In Bridge, choose Edit/Adobe Bridge CC > Camera 
Raw Preferences.

2. At the bottom of the dialog, from the JPEG menu, 
choose Automatically Open JPEGs with Settings.

3. If you shoot digital TIFF photos, from the TIFF 
menu, choose Automatically Open TIFFs with 
Settings; or if you shoot only raw or JPEG photos 
(not TIFF photos), choose Disable TIFF Support.

4. Click OK. 

When you want to open a JPEG or TIFF photo into 
Camera Raw that has not yet been edited (doesn’t 
have Camera Raw settings), click the thumbnail 
in Bridge, then click the Open in Camera Raw
button  or press Ctrl-R/Cmd-R. 

To open a JPEG or TIFF photo that has been 
edited previously in Camera Raw (that is “with 
Settings”), double-click its thumbnail or press 
Ctrl-R/Cmd-R.

➤ If you enable both “Automatically Open” options 
(steps 2–3, above), but there is an occasion when 
you want to open a JPEG or TIFF photo directly 
into Photoshop instead of Camera Raw, click the 
thumbnail, then press Ctrl-O/Cmd-O. This shortcut 
will work only if the file hasn’t yet been edited in 
Camera Raw.

➤ If the Open in Camera Raw button  is available 
when you click a thumbnail in Bridge, it’s a sign 
that the file can be opened into Camera Raw.

You can set a preference to have either Bridge or 
Photoshop host the Camera Raw plug-in when you 
open a raw or JPEG photo. In the case of Photoshop, 
the program will launch, if it’s not already running. 
Also, when Bridge is the host for Camera Raw, the 
default (highlighted) button for exiting that dialog 
is labeled Done, whereas when Photoshop is the 
host for Camera Raw, the default exit button is Open 
Image or Open Object, depending on a setting in the 
Workflow Options dialog (see step 9 on page 58).

To choose a host for Camera Raw:

1. In Bridge, choose Edit/Adobe Bridge CC >
Preferences (Ctrl-K/Cmd-K), then show the 
General pane.

2. Check Double-Click Edits Camera Raw Settings 
in Bridge if you want Camera Raw to be hosted 
by Bridge when you double-click a thumbnail in 
Bridge (a raw photo or a JPEG that was previously 
edited in Camera Raw), or uncheck this option to 
have the file open into Camera Raw hosted by 
Photoshop. Click OK.
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After setting the necessary preferences, and before 
learning the particulars of Camera Raw, you should 
familiarize yourself with this basic workflow.

To open a raw or JPEG digital photo into 
Camera Raw:

1. Launch Bridge, display the thumbnail for a raw or 
JPEG photo, then do either of the following:

For a raw photo, double-click the thumbnail. 

For a raw or JPEG photo, click the thumbnail, then 
press Ctrl-R/Cmd-R or click the Open in Camera 
Raw button on the Bridge toolbar  (or right-
click the photo and choose Open in Camera Raw).

2. The Camera Raw dialog opens.A An alert 
symbol may display in the upper-right corner 
of the preview while Camera Raw reads in the 
image data, and will disappear when it’s done. 

Information about your photo (taken from the 
metadata that was embedded into it by the 

camera) is listed in several locations: the camera 
model in the title bar at the top of the dialog; the 
file name below the preview; and the camera set-
tings used to take the photo (aperture, shutter 
speed, ISO, and focal length) below the histogram.

The adjustment features are located in 10 
tabs: Basic, Tone Curve, Detail, HSL/Grayscale, 
Split Toning, Lens Corrections, Effects, Camera 
Calibration, Presets, and Snapshots. Switch among 
the tabs to correct your photo (we cover most 
of the tabs in depth in this chapter).

3. When you’re done correcting the photo, you can 
either click Open Image to open the photo into 
Photoshop or click Done to close Camera Raw 
without opening the photo. In either case, the 
Camera Raw settings will stick to the photo, and 
the original data will be preserved. (Note: If you 
want to open the photo into Photoshop as a 
Smart Object, see the Note on page 95.)

A The Camera Raw dialog

Link to the Workflow Options dialog (see pages 58–60)

The original 
camera 
settings

Tabs (click to 
access settings)

Toolbox Toggle Full Screen Mode/previous dialog size (F)

Histogram

Camera Raw 
Settings menu

Zoom controls Preview controls ★

You can right-click the 
background area, then 
use the context menu to 
change the background 
shade, or add/delete the 
hairline border.★
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A file that you open from Camera Raw into Photoshop 
as a Smart Object can be reedited using the full array 
of features in Camera Raw at any time. A standard 
image layer in a Photoshop document can also be 
edited using most — but not all — of the Camera 
Raw features by way of the Camera Raw Filter, as 
described in the task below. If you convert the image 
layer to a Smart Object first (an optional step), you 
will be able to edit the filter settings at any time. 
Note: To learn about layers, which are used in this task, 
see Chapter 8. To learn more about Smart Objects, see 
pages 264–275. See also the first Note on page 95.

Among the Camera Raw features that aren’t avail-
able via the Camera Raw Filter are the Crop and 
Straighten tools, the rotate buttons, the Workflow 
Options dialog, the Snapshots tab, and some options 
on the Camera Raw Settings menu. Don’t be dissuaded 
by this list of “nos,” however — the filter gives you 
access to the essential Camera Raw features.

To open and edit a Photoshop image layer 
in Camera Raw:

1. In an RGB document in Photoshop, display the 
Layers panel.  Click the image layer (or the 
Background) that you want to edit in Camera Raw, 
then press Ctrl-J/Cmd-J to duplicate it. Keep the 
duplicate layer selected.A

2. Optional (but recommended): To keep your Camera 
Raw settings editable, choose Filter > Convert for 
Smart Filters, or right-click the duplicate image 
layer and choose Convert to Smart Object.B If an 
alert dialog appears, click OK. 

3. With the image layer or Smart Object selected, 
choose Filter > Camera Raw Filter (Ctrl-Shift-A/
Cmd-Shift-A).

4. The image layer opens in Camera Raw. Apply the 
needed corrections. 

5. Click OK (a progress bar may display while the 
filter is processing). 

6. If you applied the filter to a Smart Object, on the 
Layers panel, you will see a Camera Raw Filter 
listing below a Smart Filters listing.C To edit the 
Camera Raw settings at any time, double-click 
the Camera Raw Filter listing. To learn more about 
Smart Filters, see pages 360–364.

➤ To create a document via the Merge to HDR Pro 
command, and adjust the new document via the 
Camera Raw Filter, see pages 250–253.

CAMERA RAW FILTER OR PHOTOSHOP?
Although we sing the praises of Camera Raw in the 
first two pages of this chapter and strongly recom-
mend using it as a first step before opening a photo 
into Photoshop, Photoshop is no slouch when it 
comes to adjustment options. In fact, Photoshop has 
some commands and features that you won’t find in 
Camera Raw, such as adjustment layers. You can eas-
ily hide, show, clip, or restack any adjustment layer; 
edit its layer mask; and change its opacity or blending 
mode (see Chapter 12). Fortunately, you don’t have to 
decide between Camera Raw and Photoshop — you 
can use both!

A We duplicated 
an image layer.

B We converted 
the duplicate layer 
to a Smart Object.

C We applied the 
Camera Raw Filter 
to the Smart Object. 
A Smart Filters listing 
appeared below the 
Smart Object.
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The Camera Raw tools A
In the upper-left corner of the dialog, click the Zoom
tool,  then click the image preview to zoom in or 
Alt-click/Option-click it to zoom out. 

Use the Hand tool  to move a magnified preview 
image in the window (if another tool is selected, hold 
down the Spacebar for a temporary Hand tool).

For the White Balance tool,  see the sidebar on 
page 62.

Choose the Color Sampler tool,  then click in the 
image preview to place up to nine samplers. A break-
down of the RGB components below each sampler 
in the photo displays in a readout below the tool box; 
the readouts will update as you make color and tonal 
adjustments. To reposition a sampler, drag it with the 
Color Sampler tool. To remove a sampler, hold down 
Alt/Option and click it. To remove all samplers, click 
Clear Samplers.

For the Targeted Adjustment tool  (or TAT for 
short), see pages 68–69 and 73.

For the Crop tool,  see page 56.

For the Straighten tool,  see page 57.

For the Spot Removal tool,  see pages 90–91.

The Red Eye Removal tool  works like the 
Red Eye tool in Photoshop (see page 309).

For the Adjustment Brush tool,  see pages 74–78.

For the Graduated Filter tool,  see pages 86–87.

For the Radial Filter tool,  see pages 88–89.

Note: If tool settings are displaying on the right side 
of the Camera Raw dialog (if, say, you were using the 

Adjustment Brush tool) and you want to redisplay 
the row of tab icons, click one of the first seven tools.

➤ The tools in Camera Raw are “memory-loaded,” 
meaning that you can toggle them. Press a tool 
shortcut to select a different tool, then press the 
same key again to return to the original tool.

Other buttons at the top of the dialog:

➤ The Open Preferences Dialog button  (or 
press Ctrl-K/Cmd-K) opens the Camera Raw 
Preferences dialog.

➤ The Rotate 90° Counterclockwise button 
and the Rotate 90° Clockwise button  rotate 
the image. The results preview in the dialog.

MORE WAYS TO ZOOM IN THE PREVIEW
➤ Hold down Alt/Option-Spacebar and click to 
zoom out, or hold down Ctrl/Cmd-Spacebar and 
click to zoom in.

➤ Press Ctrl –/Cmd – (hyphen) to zoom out or 
Ctrl- +/Cmd- + to zoom in.

➤ Use the zoom buttons (– or +) or the Zoom 
Level menu, located below the image preview.

➤ Double-click the Zoom tool to set the zoom 
level to 100%.

➤ Double-click the Hand tool to fit the image in 
the preview window.

A The shortcuts for the Camera Raw tools are listed in boldface above.

Z Zoom: 
Reduces or 
magnifies
the preview

H Hand: Moves a 
magnified preview 
in the window

I White 
Balance: Sets 
the white 
balance

S Color Sampler:
Places up to nine 
RGB color sampler 
points in the preview

C Crop: Crops 
the photo based 
on a marquee 
you drag

A Straighten:
Straightens the 
photo along a 
line you drag

B Spot
Removal: 
Heals
imperfections

E Red Eye 
Removal: Corrects 
red-eye in a 
portrait photo

T Targeted 
Adjustment:
Applies adjust-
ments where 
you drag in 
the preview

Graduated Filter G and
Radial Filter J tools: Apply 
edits gradually across an
area that you designate

Opens the 
Camera Raw 
Preferences 
dialog

K Adjustment 
Brush: Applies 
local edits to 
areas you have 
masked

L Rotates 
the image 
90° Counter-
clockwise

R Rotates the 
image 90° 
Clockwise 
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Cropping and straightening 
photos
With the Crop and Straighten tools, you can control 
which portion of a photo opens into Photoshop. You 
can readjust the crop box at any time without losing 
any image data, and the outlying areas will remain 
available even after you click Save, Done, or Open.

To crop a photo:

1. Open a photo into Camera Raw A (see step 1 on 
page 53). 

2. Choose the Crop tool  (C).

3. Drag in the preview to make a crop box appear.B
4. Optional: To move the crop box, drag inside it. 

To resize the box, drag a handle.

5. To preview the results of the Crop tool, press 
Enter/Return or click any tool except the Crop or 
Straighten tool.C

➤ To redisplay the current crop box after exiting 
crop mode, click the Crop tool. If you want to 
remove the box and redisplay the whole image, 
press Esc.

B With the Crop tool, we drew a crop box in the preview
window. Here, we are resizing the box.

C We pressed Enter/Return to preview the results.

A This is the original photo, in Camera Raw.
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To straighten a crooked photo 
automatically:★
1. Open a photo into Camera Raw, then double-

click the Straighten tool  (A); or choose the 
Straighten tool, then double-click anywhere in 
the image.

2. Press Enter/Return.

➤ To turn the Crop tool into a temporary 
Straighten tool, hold down Ctrl/Cmd.

To straighten a crooked photo manually:

1. Open a photo into Camera Raw, then choose the 
Straighten tool  (A).

2. Drag along an edge in the photo that you want 
to align to the horizontal or vertical axis.A A crop 
box will display, aligned to the angle you drew.B

3. To preview the straighten results, press Enter/
Return.C

➤ To change the straighten results after exiting 
crop mode, choose the Straighten tool (A), then 
drag again. 

➤ If you want to remove the crop box, choose the 
Crop tool (C), then press Esc.

B A crop box displays. C We pressed Enter/Return to preview the results.

A With the Straighten tool, we are dragging along 
an edge that we want to align to the vertical axis.
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Choosing default workflow options
Via the Workflow Options dialog, you can resize or 
sharpen a photo, or change its color space or bit 
depth, before opening it into Photoshop — the origi-
nal raw or JPEG file isn’t altered. Note that the choices 
that you make in this dialog become the new default 
settings, so they apply not only to the current photo, 
but also to subsequent photos that you open into 
Camera Raw. The dialog contains new Color Space and 
Preset options (see this page and the next), as well as 
Image Sizing options (see page 60). 

To choose settings in the Workflow 
Options dialog: ★
1. Open a photo into Camera Raw, then below the 

large image preview, click the underlined link. The 
Workflow Options dialog opens (A, next page).

2. If you want to apply a user-saved preset, choose 
it from the Preset menu (B, next page).★ Next, 
either click OK to exit the dialog, or choose 
custom options, as in the remaining steps.

3. From the Space menu, choose a color profile to 
be used for converting the raw file to RGB: Adobe 
RGB (1998), ColorMatch RGB, ProPhoto RGB, or 
sRGB IEC61966-2.1 (or “sRGB,” for short). The menu 
also lists preset RGB and CMYK output profiles for 
printers and displays, as well as any other profiles
that you have installed in your system.★ In
Chapter 1, you assigned Adobe RGB (1998) as the 
default color space for color management, so for 
optimal color consistency, we recommend also 
choosing that option here.

4. The Intent options control how colors will change 
in a photo when it is converted to the chosen pro-
file. If you chose any profile from the Space menu 
except one of the first five, from the Intent menu, 
choose Perceptual or Relative. If your photos 
tend to contain many colors that are outside the 
gamut of the chosen color space, Perceptual is the 
best choice because it attempts to preserve the 
appearance of colors as it shifts them into gamut. 
If your photos contain few colors that are out of 
gamut, Relative is the best choice, as it preserves 
more of the original colors. Your photo will display 
as a soft proof (a simulation of print output from 
your target device).★

5. To control the amount of color and tonal informa-
tion in your photos, from the Depth menu, choose 
8 Bits/Channel or 16 Bits/Channel. If you choose 

16 Bits/Channel, more of the original capture 
information will be preserved in your photos as 
you edit them in Photoshop, but they will also 
have a larger file size and will require a large 
hard disk and a fast system with a lot of RAM for 
processing (see page 17). 

6. If you chose a printer profile, check Simulate 
Paper & Ink to preview the photo using the range
of black values that can be produced by that 
printer, on a simulation of white printing paper.

7. In a standard workflow, you can keep Resize to 
Fit unchecked. If, on the other hand, you need to 
resize the current photo and other photos that 
you open into Camera Raw, keep the dialog open 
after step 12, and follow the task on page 60.

 8. Camera Raw applies a Resolution of 300 ppi★
to all photos as they are opened into Photoshop. 
If needed, you can choose a different value here.

 9. Optional: Use options under Output Sharpening 
to apply predefined sharpening. Check Sharpen 
For, then from the Sharpen For menu, choose an 
output medium of  Screen, Glossy Paper, or Matte 
Paper; and from the Amount menu, choose the 
desired level of sharpening (Standard is a good 
all-purpose choice).  

➤ The sharpening values that Camera Raw 
applies via this dialog aren’t listed anywhere. 
If you want to control specific values when 
sharpening, uncheck Sharpen For and use the 
sliders in the Detail tab (see pages 70–71).

10. The Open in Photoshop as Smart Objects option 
converts the Open Image button in the main 
Camera Raw dialog to an Open Object button, 
which opens your photo into Photoshop as a 
Smart Object. 

➤ If you leave this workflow option unchecked, 
you can convert the Open Image button to 
Open Object in the main Camera Raw dialog 
(for any photo) by holding down Shift. Learn 
about Smart Objects on pages 264–275.

11. Optional: To save your current, custom Workflow 
Options settings as a preset that can be applied 
to any photo, from the Preset menu, choose New 
Workflow Preset.★ Enter a descriptive name for 
the preset, then click OK.
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12. Optional: If you chose a preset and then changed 
any of the settings in the dialog, the word “(edited)” 
is now listed in the preset name. If you want to 
permanently update the current preset with 
your new custom settings, from the Preset menu, 
choose Update [preset name].★

13. Click OK. Your chosen workflow settings will be 
applied to the current photo and to all photos that 
you subsequently open into Camera Raw.

➤ To rename a user-saved Workflow Options preset, 
from the Preset menu in the dialog, choose the 
preset to be renamed, choose Rename [preset 
name], type the desired name, then click OK.★

A Via the Workflow Options dialog, you can choose Preset, 
Color Space, Image Sizing, and Output Sharpening settings for 
the current and future photos.  

B From the Preset menu in the Workflow Options dialog, you can choose a user-saved workflow preset.

USING THE GAMUT WARNING BUTTON IN THE 
CAMERA RAW HISTOGRAM★
If you choose a printer profile from the Space menu 
in the Workflow Options dialog, instead of two clip-
ping warning buttons on the histogram in the main 
Camera Raw dialog, you will see just one Gamut 
Warning button  (O). When this button is acti-
vated, areas of the photo that are outside the gamut 
of the chosen output device will display as red in 
the preview. If you need to bring those errant colors 
back into gamut, you can use either the Vibrance 
slider in the Basic tab or the Saturation sliders in the 
HSL/Grayscale tab.

QUICK AND EASY WAY TO APPLY A 
WORKFLOW OPTIONS PRESET★
To apply a Workflow Options preset to a photo, 
instead of opening the Workflow Options dialog, 
right-click the link below the preview in the main 
Camera Raw dialog and choose a preset name from 
the context menu.
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If you need to resize multiple photos according to a 
specific criterion, such as the dimension of a long or 
short side of one of the photos, use the Resize to Fit 
feature in the Workflow Options dialog. If you don’t 
require the original high-megapixel count of your 
photos for image editing or output, shrinking them 
is an acceptable option. Enlarging photos, on the 
other hand, should be done only when necessary, as 
it diminishes their quality (preferably, don‘t enlarge 
your photos by more than 25% or 30%). 

Note: To resize or change the resolution of an indi-
vidual photo for a particular output medium, instead 
of using the options dialog in Camera Raw, we rec-
ommend using the Image Size dialog in Photoshop 
after you exit Camera Raw (see pages 136–139). The 
latter offers many image resizing options, including 
choices for resampling, with a document preview. 

To resize images via the Workflow 
Options dialog:★
1. Open one or more photos into Camera Raw, then 

click the Workflow Options link. Under Image 
Sizing, check Resize to Fit.

2. Optional: Check Don’t Enlarge if you want to 
prevent your photos from being enlarged.

3. Under Image Sizing, from the Resize to Fit
menu,A do one of the following (Camera Raw 
will resize all your photos proportionately, 
whether or not you enter proportionate values):

Choose Width & Height, then enter the desired 
maximum W and H values within which the cur-
rent and future photos will be resized. For resiz-
ing to occur, both of these values must be either 
larger or smaller than the original dimensions of 
the current photo.

Choose Dimensions,B then enter the desired 
maximum values in the two fields within which 
Camera Raw will resize your photos. Camera Raw 
will fit the longer dimension of each photo to the 
larger of the two values (regardless of the orien-
tation of the photo). You could use this option to 
resize a series of horizontal or vertical photos to 
the same long dimension.

➤ If the Width & Height or Dimensions option 
produces unexpected resizing results in 
your photos, try entering the same value in 
both fields, thereby providing a larger resiz-
ing area, or use the Long Side or Short Side 
option instead (see the next option).

Choose Long Side or Short Side, then enter the 
desired value for that dimension.

Choose Megapixels, then enter the desired total 
pixel count value. All photos will be resized to 
that value.

Choose Percentage, then enter a percentage by 
which you want your photos to be resized (pref-
erably, less than 130%, and not more).

➤ When you use the Resize to Fit option, the 
new dimensions and megapixel (MP) count 
are listed in the right side of the Image Sizing 
area. If you want to learn the original dimen-
sions of the current photo, uncheck Resize to 
Fit; the original dimensions will display in the 
dimmed W and H fields; now recheck the box.

4. Click OK. Note: Because the current settings in 
the Workflow Options dialog are applied to all 
photos that you open into Camera Raw, after 
using the dialog to resize the desired photos, exit 
Camera Raw. Upon reopening Camera Raw, be 
sure to open the Workflow Options dialog and 
uncheck Resize to Fit.

A From the Resize to Fit menu in the Workflow Options dialog, 
choose a criterion for resizing your photos.

B If you choose Dimensions as the Resize to Fit option, you 
must then enter pixel values in the two fields below the menu.
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The Camera Raw tabs

To access a panel of related settings in Camera Raw, 
click one of the tab icons (shown above). We perform 
most of our work in the first four tabs, and recom-
mend that you do the same. Use the other tabs for 
specialty corrections or enhancements, as needed.

Basic: Adjust the white balance and exposure (see 
pages 63–67).

Tone Curve: Fine-tune a specific tonal range, such as 
the upper or lower midtones (see pages 68–69).

Detail: Apply capture sharpening and reduce 
unwanted noise (see pages 70–71).

HSL/Grayscale: Adjust the hue, saturation, and lumi-
nance of individual colors (see pages 72–73).

Split Toning: Apply one color tint to the highlight 
areas of a photo and a second tint to the shadow 
areas (see page 79).

Lens Corrections: Correct a photo for the effects of 
lens distortion, such as geometric distortion (e.g., a 
building that is tilted backward or isn’t level), under- 
or overexposure at the edges (an unwanted vignette), 
chromatic aberration, and color fringes.

Effects: As a special effect, apply a grain texture or a 
light or dark vignette (see pages 84–85).

Camera Calibration: The Process menu in this tab lets 
you update a file to the latest Camera Raw processing 
(see the sidebar on the next page). If the profile that 
Camera Raw provides for your camera model doesn’t 
produce satisfactory color results, use the sliders in 
this tab to tweak the settings manually.

Presets: Create a custom preset of the current Camera 
Raw settings for future application to any other 
photos (see page 92).

Snapshots: For flexibility in editing, save interim 
versions of a photo as you make corrections. When 
necessary, you can restore the photo to any snapshot 
version (see the sidebar on page 92).

If you find a need to undo or reset your slider settings 
as you work in Camera Raw, you can use any of the 
methods below. (To learn about related options on 
the Camera Raw Settings menu, see the next page.)

To restore default settings to sliders in 
the Camera Raw tabs:

Do any of the following:

Double-click a slider to reset it to its default value 
(usually 0).

Shift-double-click a slider in the Basic tab to reset 
it to the Auto value.

Click Default in the Basic or HSL/Grayscale tab to 
reset all the sliders in just that tab to 0.

Hold down Alt/Option and click Reset at the 
bottom of the dialog (Cancel becomes Reset) to 
restore the settings, in all tabs, that were in effect 
when you opened the dialog.

Basic Detail Split Toning Effects

Tone Curve

Camera Calibration

HSL/Grayscale Presets Snapshots
Lens 

Corrections

Using the Camera Raw tabs

USING THE PREVIEW BUTTONS★
From the Before/After Views menu  below the pre-
view, choose a preview option. For instance, Before/
After Left/Right displays the original photo on the left 
(or displays the photo with the settings that were cop-
ied to the button, see below), and the photo with the 
current Camera Raw settings on the right. Before/After 
Top/Bottom Split displays the two versions in top and 
bottom halves of one image. Or if you prefer to cycle 
through the menu settings, click (and keep clicking) 
the Before/After Views button  (Q). To customize the 
views, choose Preview Preferences from the menu.

➤ To swap the positions of the previews, click the 
Swap Before/After Settings button  (P).

➤ To save the current Camera Raw settings as the 
Before state of the image, click the Copy Current 
Settings to Before button (Alt-P/Option-P). There-
after, when you choose a Before/After view, those set-
tings will display in the top or left part of the preview.

USING THE SCRUBBIES
To change a value quickly in a Camera Raw 
tab, instead of dragging a slider, drag to the 
left or right across the slider name (this is 
called a scrubby slider).
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When you open a photo into Camera Raw, by default, 
it’s adjusted according to the built-in profile for 
your camera model, and all the sliders in the Basic 
tab are set to 0. At any time, you can assign a differ-
ent collection of settings to your file, or restore the 
original settings. 

To restore settings via the Camera Raw 
Settings menu:

From the Camera Raw Settings menu,  choose 
one of these options: A
Image Settings to restore the settings that were 
attached to the file during the initial photo shoot 
or, if the photo was previously edited in Camera 
Raw, from the last Camera Raw session. When a 
photo is opened for the first time into Camera 
Raw, these settings will match the Camera Raw 
Defaults settings.

Camera Raw Defaults to remove all custom set-
tings and reapply the default settings for your 
camera model, your specific camera, or the ISO 
setting that was used to take the photo.

Previous Conversion to apply the settings from 
the prior image that was adjusted in Camera Raw.

Custom Settings to reapply the custom settings
that you have chosen since opening the photo 
into Camera Raw.

If a user-saved preset is applied to the current 
photo, that preset will also be listed as an option 
on this menu (see page 92).

UPDATING LEGACY PHOTOS AND THE 
CAMERA RAW SLIDERS
When you bring an unprocessed photo into Camera 
Raw 8.x, the dialog uses its most up-to-date profiles 
for noise reduction, de-mosaicing, sharpening, color 
calibration, and other processing. If you want to 
update a raw photo that was already processed in 
Camera Raw 6 or earlier using the new profiles, and 
also update the sliders in the Basic and other tabs to 
the newest versions (as described in this chapter), 
before applying any custom adjustments, click the 
Update to Current Process (2012)  icon at the bot-
tom right of the preview window. The Process menu 
in the Camera Calibration tab  changes to the set-
ting of 2012 (Current). Note: If you want to preserve 
access to the older rendering of the photo, take a 
snapshot of it before you update it (see the sidebar 
on page 92).

SETTING THE WHITE BALANCE
The color temperature of the lighting in which a 
photo is shot, whether natural or artificial, influences 
the relative amounts of red, green, and blue that are 
recorded by the camera. A digital camera attempts 
to balance the three colors to produce an accurate 
white, which in turn makes other colors in the photo 
more accurate; this is called the “white balance.” 

There are a few ways to adjust the white balance 
of a photo in Camera Raw. Note: Before adjusting 
the white balance, make sure your display is prop-
erly calibrated.

➤ Our recommended method is to drag the 
Temperature and Tint sliders in the Basic tab, choos-
ing settings based on how the photo looks to your 
eye (see the next page).

➤ For photos that are shot in controlled lighting, 
such as in a studio, another method is to use the 
White Balance tool  (I). Drag (don‘t click) to define 
a rectangle on a medium to light gray area of the 
photo — if you can find one. Camera Raw will set the 
White Balance based on pixel values in the sampled 
area. Note that although the White Balance tool is 
improved, sampling a larger area of “nearly gray” 
pixels than before,★ the resulting color tempera-
ture and tint correction may still not be adequate, 
and may need further adjustment.

➤ Here’s an iffy, but quick, method: Shift-double-
click the Temperature slider, and Shift-double-click 
the Tint slider. Camera Raw will apply auto settings 
for those controls.★A Use options on the Camera Raw Settings menu to restore 

default settings to your photo or to reapply the prior settings.

TOGGLING THE ACR DEFAULT SETTINGS★
To quickly toggle between the current (custom) 
settings and the Adobe Camera Raw Default settings 
for your photo, click the rightmost button below 
the preview  (Ctrl-Alt-P/Cmd-Option-P). If the 
photo is displayed in a divided preview, the default 
settings will display in just the “After” section.
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C A Temperature value of 5500 strikes a good balance 
between warm and cool.

B We lowered the Temperature value too much. Now the 
photo looks too cool (has a bluish cast).

A When a photo is opened for the first time into Camera 
Raw, the White Balance menu in the Basic tab is set to As 
Shot. This photo has a high Temperature value and looks 
too warm (yellowish).

Using the Basic tab
As its name implies, the Basic tab contains the most 
essential correction features of Camera Raw — and it 
displays first, by default, when you open the dialog. 
We have divided the use of this tab into several tasks, 
beginning with setting the White Balance, on this page, 
then proceeding through exposure, contrast, and satu-
ration adjustments, on pages 64–67. 

To apply white balance adjustments via 
the Basic tab:

1. With a photo open in Camera Raw, click the Basic
tab. A If the whole photo isn’t visible in the pre-
view, double-click the Hand tool  in the toolbox.

2. Do either of the following:

From the White Balance menu, choose a preset 
that best describes the lighting conditions in 
which the photo was taken, such as Daylight or 
Shade. (Choose As Shot, if needed, to restore the 
original camera settings. Note that only As Shot 
and Custom are available for JPEG and TIFF files.)

Lower the Temperature value to add blue and 
make the image look cooler,B or raise it to add 
yellow and make the image look warmer.C To fine-
tune the temperature correction, move the Tint
slider slightly to the left to add a bit of green or 
to the right to add magenta. (The White Balance 
menu setting changes to Custom, to indicate that 
you have chosen manual settings.)



64 Chapter 4

On the histogram in the Camera Raw dialog, the red, 
green, and blue areas represent the three color chan-
nels in a photo, and the white areas represent the 
areas where those three colors overlap. Clipping, the 
shifting of tonal values to absolute black or white in 
a photo, occurs if the tonal range of a scene is wider 
than the range that can be captured by the camera. 
You can tell that pixels are clipped in a photo if the 
vertical bars are primarily clustered in taller peaks at 
one or both ends of the histogram (shadow pixels 
on the left, highlight pixels on the right). You can also 
drag in the histogram to apply tonal adjustments.★

As you make slider adjustments in Camera Raw, 
your goal is to bring the pixels into the range of your 
chosen RGB color space and minimize clipping. When 
tonal values are redistributed, the histogram updates 
accordingly. Note: Remember, we recommended that 
you choose Adobe RGB as the color space both for 
your camera (see page 5) and for photos that you 
open into Camera Raw (see page 58). 

To turn on the histogram clipping 
warnings for the preview:

In the top-left corner of the histogram, click the 
Shadow Clipping Warning button (U);A clipped 
shadows display in the preview as blue. In the top-
right corner, click the Highlight Clipping Warning
button (O); clipped highlights display in the pre-
view as red. (When a button is activated, it has a 
white border.)

In the two tasks that follow this one, we show you how 
to use a number of sliders in the Basic tab. Once you 
learn the function of the sliders, remember that you 
can also make adjustments by dragging in the histo-
gram, as described here.

To make tonal edits via the histogram: ★
1. In Camera Raw, display the Basic tab,  then roll 

over the histogram.A As you move the pointer, 
one of five vertical gray drag zones will appear. 
The drag zone, as well as the data in the info area 
below the histogram, corresponds to one of these 
five sliders: Blacks, Shadows, Exposure, Highlights,
or Whites.

2. Drag horizontally in a drag zone to adjust that 
tonal range; the corresponding slider will shift 
accordingly.B

Instructions continue on page 66

B When we positioned our pointer within the drag 
zone for the Shadows range in the histogram, then 
dragged horizontally, the corresponding Shadows 
slider in the Basic tab shifted accordingly.

Use the middle batch of sliders in the Basic tab to 
apply tonal corrections to your photo, preferably in 
the order listed in the dialog (there’s a logic to their 
sequence). At first, all the sliders are set to 0 and the 
underlined word “Default” is dimmed. 

To apply exposure and contrast 
adjustments via the Basic tab:

1. Turn on the Clipping Warning buttons.

2. Use the Exposure slider to lighten or darken the 
entire photo, as needed.

3. Use the Contrast slider to increase or reduce the 
color intensity and tonal contrast (A–B, next page).

A When we rolled over an area of the histogram, a
drag zone appeared, and the corresponding Basic 
slider name and setting appeared in the info area.

Shadow Clipping 
Warning button

Highlight Clipping 
Warning button
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B Our first goal is to lighten the overall photo and recover details in the midtones 
and shadows without washing out the highlights. In the Basic tab, we increased 
the Exposure value,* then increased the Contrast value to intensify the highlights, 
shadows, and color saturation. We’re not concerned that the photo is still too dark, 
as it can be lightened with further adjustments.

*We chose an Exposure value of +0.60 for the raw version of this photo. If you are working with the JPEG version that we have 
supplied for downloading, use an Exposure value of +0.80 instead.

A This original photo was underexposed (too dark), causing the colors to look dull. The blue 
warning color in the preview indicates the shadow areas in the photo that are clipped. 
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A We reduced the Highlights 
value to recover details in the sky 
and increased the Shadows value 
to recover details in the shadows 
and lower midtones. The colors 
and detail in the midtones, and the 
overall balance of lights and darks, 
are improved. However, reducing 
the Highlights value caused the 
white areas to look dull.

4. If you increased the contrast, the highlights and 
shadows probably now need to be adjusted:

To restore details in the highlights, move the 
Highlights slider to the left until only a smidgen 
remains of the red highlight warning color.

To restore details in the shadows, move the 
Shadows slider to the right until only a smidgen 
remains of the blue shadow warning color.A Or 
if you need to darken the shadows, move this 
slider to the left.

5. Now that details have been restored to the mid-
tones and highlights, you’re ready to adjust the 
whites and blacks:

Increase the Whites value to brighten the white 
areas in the photo. This slider also has the effect 
of lightening the upper midtones and brighten-
ing the colors.

Use the Blacks slider to lighten or darken the 
black areas (A, next page). This slider may also 
affect the color brightness.

➤ If the colors are now washed out as a result 
of your increasing the Whites or Blacks value, 
you could try increasing the Contrast value.

➤ To further adjust the tonal values in the 
midtones, see pages 68–69.

➤ To have Camera Raw set the Whites or Blacks 
value automatically, hold down Shift while 
double-clicking one of those sliders.★

REMOVE CLIPPING IN THRESHOLD PREVIEW
To remove shadow clipping a different way, Alt-drag/ 
Option-drag the Shadows or Blacks slider. A Threshold 
preview displays (as shown below). Release the mouse 
when small amounts of color or black display in the 
white preview. 

You can also Alt-drag/Option-drag the Exposure, 
Highlights, or Whites slider to display a Threshold 
preview for that adjustment. Release the mouse when 
only a smidgen of white displays in the black preview.
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A We increased the Whites value 
to lighten the upper midtones 
and brighten the whites, and 
increased the Blacks value to 
recover more details in the shad-
ows. Overall, the brightness, as well 
as the colors, are much improved.

B Finally, we increased the Clarity 
value slightly to sharpen the 
details and increased the Vibrance 
value slightly to boost the color 
saturation (note the change 
on the car body). Our cumula-
tive adjustments to this photo 
improved the contrast, clarified 
the details, and produced richer 
color. Vroom, vroom!

To apply edge contrast and color saturation adjustments using the Basic tab:

1. To add depth by intensifying the edge contrast in 
the midtones, increase the Clarity value; or for a 
deliberate soft-focus effect (such as in a portrait or 
landscape), reduce the Clarity value.

2. Change the Vibrance value to adjust the color 
saturation.B

3. Turn off both clipping warnings by pressing U, 
then O. 

➤ We recommend using the Vibrance slider instead 
of the Saturation slider to adjust color saturation 
because the former is less likely to cause oversatu-
ration (and it protects skin tones), whereas the 
latter is more likely to cause oversaturation and 
highlight clipping. To view the effect of this, drag 
the Saturation slider to the far right.
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Using the Tone Curve tab
After using the Basic tab, a next logical step is to 
make a more refined adjustment of the upper 
and lower midtones, which we recommend doing 
individually via the Parametric sliders in the Tone 
Curve tab.

Note: We avoid manipulating the curve in the 
nested Point tab, because a misshapen curve can 
cause a photo to look posterized. The sliders in the 
Parametric tab don’t cause this problem.

To apply tonal adjustments using the 
Parametric sliders in the Tone Curve tab:

1. With a photo open in Camera Raw,A click the 
Tone Curve tab,  then the nested Parametric
tab. Behind the curve you’ll see a static display of 
the current histogram.

2. Do either of the following:

If you have already adjusted the Highlights 
and Shadows sliders in the Basic tab, leave the 
Highlights or Shadows sliders in this tab alone 
and just tweak the upper and lower midtones 
using the Lights and Darks sliders. If you didn’t 
adjust the Highlights and Shadows sliders in the 
Basic tab, you can use the sliders here to lighten 
or darken any individual tonal range: Highlights,
Lights (upper midtones), Darks (lower mid-
tones), or Shadows. As you move a slider, the 

corresponding portion of the curve will be 
raised above or lowered below the diagonal line 
(A–B, next page). 

Click the Targeted Adjustment tool  (T). Drag 
within a tonal range of the photo that needs 
adjustment (C, next page). As you do this, the 
slider and curve that correspond to the tonal 
range under the pointer will move accordingly.

➤ To boost the contrast in a photo, try moving 
the Lights slider to the right and the Darks 
slider to the left. 

3. To control the range of tonal values that are 
affected by the slider adjustments you made in 
the preceding step, move any of the region con-
trols (located below the graph). The left region 
control affects the Shadows slider, the right 
region control affects the Highlights slider, and 
the middle region control affects both the Lights 
and Darks sliders (D–E, next page). Move a 
control to the left to raise the curve and lighten 
adjacent tonal ranges, or move a control to the 
right to lower the curve and darken adjacent 
tonal ranges. 

➤ To use one shortcut to get to the nested 
Parametric tab in the Tone Curve tab and 
select the Targeted Adjustment tool, press 
Ctrl-Alt-Shift-T/Cmd-Option-Shift-T.

A In this photo, the midtones are too dark — few details are visible in those areas.
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A To lighten the lower midtones, we 
increased the Darks value. This adjustment 
raised the middle of the curve.

D Finally, we moved the middle region 
control slightly to the right, which had 
the effect of increasing the contrast and 
lightening the sky. 

B More details are now visible in the lightened midtones, such as on the sides of the 
buildings and on the side and surface of the canal. However, the sky looks a bit dull.

E Now the tonal values in the image look just right.

C To lighten the upper mid-
tones (and thereby brighten 
the clouds, sky, and trees), we 
dragged upward over a light 
midtone area with the Targeted 
Adjustment tool;  the Lights 
value increased automatically. 
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All digital cameras produce some luminance (gray-
scale) noise and color artifacts (randomly colored 
pixels). Although budget cameras tend to produce 
the most noise, it can also be produced by a high-end 
camera if it’s used with a high ISO (light sensitivity) set-
ting in a poorly lit scene. It’s a good practice to remove 
as much noise from your photos as possible in Camera 
Raw, because it can become accentuated by image 
editing in Photoshop. 

As you follow these steps, you’ll discover that after 
you shift one slider, another slider will need adjusting.

To reduce luminance and color noise 
using the Detail tab:

1. With a photo open in Camera Raw (A, next page), 
click the Detail tab  and choose a zoom level of 
200–300% for the preview.

2. To reduce grayscale noise (graininess), increase 
the Luminance value (B, next page). Try a value 
between 20 and 70.

3. Increasing the Luminance can cause high-contrast 
edges in a photo to lose definition. To resharpen 
edges, raise the Luminance Detail value — but not 
so much that you reintroduce noise (C, next page). 

➤ To move a different area of the photo into 
view, hold down the Spacebar and drag.

4. Raise the Luminance Contrast value to restore 
some edge contrast. The effect of this slider is most 
noticeable in photos that contain a lot of noise.

5. Color artifacts and random speckling tend to be 
most noticeable in solid-color areas of a photo 
(e.g., flat surfaces), especially in shadow areas. 
To reduce these defects in a raw photo, increase 
the Color value to around 40–50, depending on 
the subject matter (for a JPEG photo, which has a 
default Color value of 0, use a lower Color value).

6. Raising the Color value may lower the intensity of 
colors in areas of the photo that were poorly lit. 
To restore some saturation and intensity to those 
areas, increase the Color Detail value from the 
default value of 50 to around 75, or just until the 
color saturation looks good (D, next page). 

7. To help reduce color mottling and artifacts in dark, 
low-contrast (low-frequency) areas of the photo, 
use the Color Smoothness slider.★

8. Lower the zoom level for the preview to judge the 
overall effect of the Detail settings.

Using the Detail tab
Via the Sharpening sliders in the Detail tab, you can 
adjust the sharpness of your photo (a process called 
“capture” sharpening), and via the Noise Reduction 
sliders, you can reduce any unwanted color noise.

To sharpen a photo using the Detail tab:

1. Click the Detail tab A and choose a zoom level
of 100%. In the preview, drag to reveal an area of 
the photo that has some detail (hold down the 
Spacebar for a temporary Hand tool).

Note: If the words “Sharpening (Preview Only)” 
display at the top of the Detail tab, click the Open 
Preferences Dialog button in the toolbox. In 
the Camera Raw Preferences dialog, choose Apply 
Sharpening To: All Images, then click OK.

2. Under Sharpening, adjust the Amount value for 
the degree of edge definition. For subject matter 
that needs a lot of sharpening, such as hard-edged 
objects or buildings, try a value of 100; if less 
sharpening is needed, try a value of 50–60. (For a 
raw photo, the default Amount value is 25; for a 
JPEG photo, the default value is 0.)

➤ To better evaluate the Amount value via a 
grayscale preview, Alt-drag/Option-drag the 
slider.

3. Use the Radius slider to control how many pixels 
surrounding each sharpened edge are modified. 
We keep this value between 1 and 1.3.

4. Alt-drag/Option-drag the Detail slider slightly to 
the right to emphasize edge details and textures.

5. Alt-drag/Option-drag the Masking slider to around
50 to protect low-contrast areas with a black mask, 
and thereby sharpen only high-contrast areas.

A These are the Sharpening controls in the Detail tab.
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A This is a close-up of a photo of a 
shop window (viewed at a zoom level 
of 300%), with the Noise Reduction: 
Luminance and Color sliders in the 
Detail tab set to 0 (no noise reduction 
applied). Grayscale noise is evident 
in the signage, and color artifacts 
are evident on the poorly lit interior
surfaces behind the letters. 

D To remove color artifacts from the dark areas, 
we increased the Color value to 40; this also had 
the effect of desaturating the colors. To revive the 
colors and produce the final version of the image 
(shown at left), we increased the Color Detail 
value to 60.

B To remove noise from the letters, we increased 
the Luminance value to 69, but this also dimin-
ished the edge definition.

C To resharpen the 
edges of the letters, we 
increased the Luminance 
Detail value to 65.

ANOTHER WAY TO 
REDUCE NOISE
To reduce noise in select 
areas via the Adjustment 
Brush tool and a mask, see 
pages 74–78.
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Using the HSL/Grayscale tab
Using the powerful sliders in the HSL/Grayscale tab, 
you can adjust the hue, saturation, and luminance of 
each color component of a photo individually.

To adjust individual colors via the HSL 
sliders:

1. Click the HSL/Grayscale tab,  and double-
click the Hand tool to fit the image in the 
preview.A

2. Click the nested Hue tab. Move any slider to 
shift that color into adjacent hues, as shown in 
the bar. For example, you could shift the Greens 

slider toward yellow to make a landscape look 
warmer, or toward aqua to make it look cooler. 

3. Click the Saturation tab. Move any slider to the 
left to desaturate that color (add gray to it) or to 
the right to make it more vivid (pure).B–C Avoid 
oversaturating the photo, to keep it looking real-
istic and so it stays printable. 

➤ To make a bluish sky more vivid, increase the 
saturation of the Blues and Aquas. To make a 
sunset look warmer, increase the saturation 
of the Oranges or Yellows.

A In the original photo, the sky lacks contrast and the reds on the car body 
are slightly undersaturated. 

C The Saturation adjustments intensified the reds in the car (particularly in 
the upper midtones) and intensified the blues in the sky.

B In the nested Saturation tab of the HSL/
Grayscale tab, we reduced the saturation of 
the Yellows and increased the saturation of the 
Reds and Blues.
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A In the nested Luminance tab, we lightened 
the Oranges and darkened the Reds, Yellows, 
Greens, and Blues. (Tip: Reducing the Blues 
value can make a photo look as if it was shot 
with a polarizing filter on the camera.)

B Decreasing the luminance of the Blues darkened the colors in the sky, 
while decreasing the luminance of the Reds and increasing the luminance of 
the Oranges produced a brighter, richer red on the car body. Now the colors 
are equally intense in the upper and lower areas of the photo.

USING THE TARGETED ADJUSTMENT TOOL
To apply local color adjustments to a photo, 
hold down Ctrl-Alt-Shift/Cmd-Option-Shift and 
press H, S, or L. The nested Hue, Saturation,
or Luminance tab in the HSL/Grayscale tab 
displays and the Targeted Adjustment tool 
becomes selected. Drag upward or to the right 
over a color area to increase the slider values 
specifically for that area, or downward or to 
the left to decrease those values. The sliders 
that correspond to the color under the pointer 
will shift automatically.

4. Click the Luminance tab.A–B Move a slider to 
the left to darken that color (add black) or to the 
right to lighten it (add white). Avoid lightening 
any of the colors too much, to prevent the high-
lights from being clipped.

➤ For a more accurate rendering of your adjusted 
pixels, choose a zoom level of 66% or 100% for 
the Camera Raw preview.
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Using the Adjustment Brush tool
Unlike corrections that are made in the Camera Raw 
tabs, which apply to the overall photo, corrections 
made with the Adjustment Brush tool are “local” (affect 
specific areas of the photo). You apply a mask in the 
preview to define which areas are going to be affected 
by the adjustment, then you apply the correction via 
the sliders. Use this tool after you have finished your 
broad, overall corrections, to fix a few specific areas or 
to accentuate some details.A Awesome feature!

To apply local edits with the Adjustment 
Brush tool:

1. After making adjustments in the Basic and 
Tone Curve tabs, click the Adjustment Brush 
tool  (K). The sliders for the tool display (some 
are like the sliders in the Basic tab).

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3. For the brush settings (the last four sliders), try a 
Feather value of 50–95 (to allow the edits to fade 
into surrounding areas), a Flow value of 60 (for the
amount of adjustment produced by each stroke), 
and a Density value of 60 (for the level of transpar-
ency in the stroke).

4. Check Mask (Y) (scroll down in the settings area 
if you don’t see this option), adjust the brush size 
by pressing [ or ], then draw strokes over areas of 
the photo that need the same adjustment. A tint 
covers the areas where you apply strokes, and a 
pin appears where you started dragging.B
➤ The brush size is represented by the solid 

circle in the pointer; the feather value is repre-
sented by the black-and-white dashed circle.

5. Uncheck Mask, then use the sliders to apply 
adjustments to the masked areas (A, next page).

➤ To show or hide all the pins, press V or check 
or uncheck Overlay. 

➤ To display the mask for an existing pin tem-
porarily, with your mouse or stylus, roll over 
the pin.

B We clicked the Adjustment Brush tool, zeroed out the 
sliders, checked Mask, then drew strokes on the broad areas 
of the face in the preview, being careful to avoid the key 
facial features.

A We studied this photo and decided what improvements 
to make: Smooth the skin, sharpen the eyelashes, darken 
the eyebrows, and minimize the under-eye circles. 
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A We hid the mask, then chose a higher 
Tint value to add magenta to the skin tones, 
higher Exposure and Shadows values to 
lighten the skin tones, and lower Clarity and 
Sharpness values to smooth the skin texture. 
The results are shown at right.

B To sharpen the eyelashes, we clicked New, showed the 
mask, then covered the lashes using a small brush. 

C We hid the mask, then chose higher Contrast, Clarity, and 
Sharpness values to accentuate the masked areas, and a 
lower Exposure value to darken them.

6. To apply different adjustment settings to another 
area of the photo, click New, then repeat steps 2–5 
B–C (and A–E, next page). 

If you want to duplicate a pin and its mask, hold
down Ctrl-Alt/Cmd-Option and drag the pin (you 
don’t have to click it first). Or click a pin, right-click 
it and choose Duplicate from the context menu, 
then drag the new pin.★

7. To redisplay the main Camera Raw tabs, press H 
(Hand tool).
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D We hid the mask again, then reduced 
the Temperature value to cool the redness 
of the skin tones; increased the Exposure, 
Highlights, and Shadows values to lighten 
the skin; and reduced the Clarity and 
Sharpness values to soften the skin texture.

E This final image shows the cumulative results of all the local 
corrections that we applied via the Adjustment Brush tool.

C To minimize the dark circles under the eyes, we 
clicked New, checked Mask, then applied a mask 
to those areas. 

A To darken the eyebrows, we clicked New, checked 
Mask, then masked those areas.

B We hid the mask, then chose a higher Contrast value to 
define the hairs more crisply against the skin, and lower 
Highlights and Shadows values for a darkening effect.
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USING THE AUTO MASK OPTION WITH THE 
ADJUSTMENT BRUSH TOOL
To mask an area according to color, zoom into that 
area. Check Auto Mask (M), position the Adjustment 
Brush tool over the color, scale the brush tip to cover 
just the width of the area, and start drawing a stroke. 
The mask will cover only the areas that match the first 
color area the brush touches. 

➤ If you want to change the mask overlay color, click 
the Mask Overlay Color swatch, then choose a color in 
the Color Picker.

A After using the Adjustment Brush tool in this photo, we 
clicked an existing pin, and checked Mask to display the mask 
associated with that pin (we changed our mask color to yellow).

B We dragged with the Adjustment Brush tool to add an 
area to the mask for the currently selected pin (note the brush 
cursor on the right side of the photo).

To edit an Adjustment Brush tool 
correction: 

1. Choose the Adjustment Brush tool  (K).

2. Check Mask (Y) and Overlay (V).

3. Click a pin. A black dot appears in the center of 
the pin.

4. Do any of the following:

To add areas to the mask, drag with the brush in 
the image preview.A–B
To move the mask to a different area of the photo, 
drag its pin.★
To adjust the correction for the current pin, 
uncheck Mask (Y), then move the sliders.
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To remove Adjustment Brush tool edits:

1. Choose the Adjustment Brush tool  (K).

2. Check Mask (Y) and Overlay (V).

3. Do either of the following:

To remove adjustments locally, click a pin, click 
the Erase button (or hold down Alt/Option), then 
apply strokes where you want to erase the mask.A
To remove a pin and its adjustments, click the 
pin, then press Backspace/Delete; or right-click a 
selected pin, then choose Delete from the con-
text menu;B or hold down Alt/Option and click 
a selected or unselected pin (note the scissors 
pointer).★

➤ To remove all Adjustment Brush tool edits from 
the current photo and reset the tool mode to New, 
click the Clear All button.

A We clicked an existing Adjustment Brush pin, and checked 
Mask to display the mask associated with that pin. Next, 
we clicked the Erase button, then dragged with the brush to 
remove an area from the selected mask.

B To remove a selected Adjustment Brush pin, we right-
clicked it and chose Delete from the context menu.
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Using the Split Toning tab
Using the Split Toning controls, you can apply one 
color tint, or tone, to the highlight areas of a photo 
and a different tint to the shadow areas. For the best 
results with this technique (and to mimic its traditional 
origins), convert the colors in your photo to grayscale 
first. We’ve gotten good results on photos of metallic 
objects, such as the antique car shown here.A

To apply a color tint to a grayscale version 
of a photo:

1. Click the HSL/Grayscale tab, then check 
Convert to Grayscale.

2. Click the Basic tab, and adjust the exposure and 
contrast.

3. Click the Split Toning tab.

4. Move both of the Saturation sliders approximately 
halfway across the bar to make it easier to judge 
the colors you will apply in the next step (don’t 
worry that the photo looks awful).

5. Move the Highlights Hue slider to tint the high-
lights B and the Shadows Hue slider to tint the 
shadows.

6. Readjust the Saturation value for each hue.

7. Reduce the Balance setting to apply more of the 
Shadows tint to the entire photo, or increase it 
to apply more of the Highlights tint to the entire 
photo.C–D

A This is the original, full-color photo.

B After converting the colors in the photo to grayscale, we 
used the Split Toning tab to tint the highlights with a brownish 
yellow hue.

D This is the final result of our Split Toning adjustments. Applying 
separate tints to the highlights and shadows accentuated the lines and 
graceful curves of this sleek antique.

C Next, we tinted the shadows with blue, 
then moved the Balance slider to the right to 
favor the highlight color more. 
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Using the Lens Corrections tab
Via the Lens Corrections tab in Camera Raw, you can 
correct a photo for various adverse effects of lens dis-
tortion. You can straighten out an architectural feature, 
such as a building or fence, that looks as if it’s leaning 
toward or away from the viewer, or that is tilted hori-
zontally (isn’t level); and you can correct for under- or 
overexposure at the edges of a photo (vignetting). The 
corrections can be applied using a preset profile (this 
page) or manually (pages 81–83).

To correct geometric distortion and 
vignetting via Profile settings:

1. Click the Lens Corrections tab. Double-click the 
Hand tool to fit the image in the preview.

2. To access predefined lens profiles, click the Profile
tab, then check Enable Lens Profile Corrections.

3. From the Setup menu,A do the following:

Choose Auto to have Camera Raw read the EXIF 
metadata in the photo and attempt to select the 
proper lens make, model, and predefined profile. 

If an error message indicates that the Auto option 
was unable to locate a profile, choose your lens 
manufacturer from the Make menu.B Camera Raw 
will locate a matching lens model and list it on the 
Model menu, and will locate a predefined profile 
and list it on the Profile menu. If the Model menu 

lists more than one model, choose the one with 
which the photo was shot.

4. Under Correction Amount, do the following:

Set the Distortion value to control the amount 
of correction.

Set the Vignetting value to correct for under- or 
overexposure at the edges of the photo.

5. Optional: If Camera Raw managed to locate your 
lens profile (step 3), you can save that profile and 
any custom Correction Amount settings as your 
new default profile by choosing Save New Lens 
Profile Defaults from the Setup menu. In future 
Camera Raw editing sessions, if you choose Default 
from the Setup menu, and the current photo was 
taken with this lens, the saved profile and settings 
will be applied. (To restore the Adobe predefined 
settings for your chosen lens, from the Setup 
menu, choose Reset Lens Profile Defaults.)

6. Optional: If you want to further correct any lens 
distortion manually, see the next task.

➤ When applying lens corrections to a Smart Object 
in Photoshop, we use the Lens Corrections tab in 
Camera Raw (accessed via Filter > Camera Raw 
Filter) because it has more extensive manual con-
trols than the Lens Correction filter in Photoshop.

A Check Enable Lens Profile Corrections, 
then choose Auto from the Setup menu …

B … or choose your lens maker from the 
Make menu. Regardless of the Setup option, 
if necessary, adjust the Distortion value.
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To correct geometric distortion or vignetting via the Manual tab:

1. Click the Lens Corrections tab,  and double-click
the Hand tool to fit the image in the preview.A

2. Click the Manual tab.B
3. In the Upright area, click a button to apply a preset 

correction:

Auto  to apply level correction and fix horizontal 
and vertical convergence, balanced with as little 
distortion as possible.C
Level  to apply only level correction (not fix hori-
zontal or vertical convergence).  

Vertical to apply level correction and fix vertical 
convergence (but not horizontal convergence).

Full  for a stronger correction of horizontal and 
vertical convergence, in addition to level correction
(A, next page).

4. If further manual correction is needed, do any of 
the following: 

To spread the image out (fix pincushion distor-
tion), lower the Distortion value; or to pinch the 
image inward (fix barrel distortion), increase the 
Distortion value.

➤ To display a grid over the image so you 
can check the alignment, check Show 

Continued on the following page

A The original photo (above) shows signs of lens distortion: The house 
looks as if it’s tilting away from the camera, and it’s not level.

B We clicked the Manual tab (under Lens 
Corrections) to access these menu options 
and sliders.

C Under Upright, we clicked the Auto button for a balanced correction. This partially corrected the vertical lines 
and vertical tilt, but the left side of the house still looks as if it’s farther away from the viewer than the right side.
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A We clicked the Full button instead, which successfully made the house 
level and upright. To lighten the outer areas of the photo, we increased 
the Amount value (under Lens Vignetting).

Grid or press V. Adjust the grid size via the 
slider.B

To widen the top of the image, (correct key-
stoning) reduce the Vertical value; to widen the 
bottom of the image, increase the Vertical value. 
Readjust the Distortion value, if needed.

To widen the left edge of the image, reduce the 
Horizontal value; to widen the right edge of the 
image, increase the Horizontal value.

To rotate the image, change the Rotate value.

To enlarge or shrink the photo, change the Scale
value. Note: You could crop the photo instead.

To stretch the image horizontally or vertically, 
change the Aspect value. This option is useful for 
correcting strong perspective distortion in photos 
taken with a wide-angle lens (A–B, next page).

➤ If you moved the Distortion slider, you can 
click Reanalyze (below the buttons) to force a 
recalculation of the Upright correction based 
on the Distortion value. If you want to turn 
off (but preserve) all your Upright corrections, 
click the Off button.  If you click a different 
Upright button, as an alert will inform you, all 
the Transform sliders (except Distortion) will 
be reset to 0.

5. To correct or apply Lens Vignetting (lighten or 
darken the outer areas of the photo), set the 
Amount value for the strength of the correc-
tion, then set the Midpoint value to expand the 
vignette inward or outward. Readjust the Amount 
value, if needed.

B We made some minor 
Vertical and Rotate adjust-
ments, with Show Grid checked 
to help us gauge the effect.
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A We tried increasing the Aspect value, but 
this setting exaggerated and distorted the ver-
ticals of the house too much.

SYNCING LENS CORRECTIONS TO MULTIPLE PHOTOS
To apply Lens Corrections edits to multiple photos that you open into 
Camera Raw:

➤ If the photos don’t require 
exactly the same corrections, click 
one photo, choose settings in the 
Manual tab of Lens Corrections, 
then on the left side of the dia-
log, click Select All, then click 
Synchronize. In the dialog, choose 
Lens Corrections from the menu, 
check only Transform and Lens 
Vignetting, then click OK. Camera 
Raw will analyze and correct each 
photo separately (see also page 94). 

➤ If the photos do require exactly 
the same correction (e.g., brack-
eted shots of the same subject), 
click one photo, then click an 
Upright button in Lens Corrections. 
Click Select All on the left side of 
the dialog, then click Sync Results
in Lens Corrections. The first photo 
will be analyzed according to the 
chosen Upright mode, then the 
same correction will be applied to 
all the other photos.

B Instead, we set the Aspect value to –5, which exaggerated the horizontal propor-
tion only slightly. The final settings we chose for the image are shown at right.
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Using the Effects tab
In traditional photography, the faster the film speed, the 
larger and more apparent the grain. As an intentional 
effect, you can simulate this grainy texture via the Grain 
controls in Camera Raw. Choose a photo that won’t 
suffer aesthetically when its details lose definition.

To add a grain texture to a photo: 

1. Click the Effects tab,  and double-click the Hand 
tool to fit the image in the preview.A

2. To create a noticeable grain, under Grain, choose an 
Amount value of around 50.

3. To emulate the fine grain of slow film or the coarse 
grain of fast film, do as follows:

Set the Size value for the size of the grain particles.B
When this value is greater than 25, a small degree of 
blurring is also applied, to help blend the grain with 
the imagery.

Reduce the Roughness value below the default 
value of 50 for a more uniform grain, or increase it 
for an uneven, coarse grain.C Zoom in to examine 
the grain, then readjust the Amount value, if needed.

C We increased the Amount to 75, the Size to 60, and the 
Roughness to 65. The coarser grain unifies the highlights and 
background with the food textures even more. Please pass 
the Parmesan…

B The first settings we chose were Grain Amount 50 and 
Size 80 (we left the Roughness control at the default value of 
50). The food textures are beginning to blend with the soft 
background. 

A This photo is a good candidate for the Grain effect 
because we won’t mind if the details are softened and 
it contains muted colors.
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Using the Post Crop Vignetting controls, you can apply a 
light or dark vignette to a photo (lighten or darken the 
outer areas). If you crop the photo subsequently in Camera 
Raw, the vignette will reconform to the new dimensions.

To apply a vignette to a photo: 

1. Click the Effects tab, and double-click the Hand 
tool to fit the image in the preview.A

2. Under Post Crop Vignetting, do all of the 
following: B–D
Choose Style: Highlight Priority.

Choose a negative Amount value for a dark vignette 
or a positive value for a light vignette.

Adjust the Midpoint value to expand the vignette 
inward or outward.

Adjust the Roundness value to make the vignette 
shape more oval or more like a rounded rectangle.

Adjust the Feather setting to control the softness 
of the transition to the nonvignetted areas.

Adjust the Highlights setting to control the bright-
ness of the highlights within the vignette area.

A This is the original image.

C We lowered the Midpoint value and 
raised the Feather and Highlights values.

D When we cropped the image, the 
vignette readjusted automatically. 

B In the Effects tab, under Post Crop 
Vignetting, we chose the values above.
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Using the Graduated Filter tool
When shooting landscapes, you may have run into 
this common predicament: You set the proper expo-
sure for the foreground, and the sky winds up being 
overexposed. To solve this problem on site, you can 
reduce the light on the upper part of the lens with a 
graduated neutral-density filter. To darken a sky in 
a photo that is shot without such a filter (Plan B!), you 
can use the Graduated Filter tool in Camera Raw. 

With this tool, you create an overlay to define the 
area to be edited, then you apply the adjustment via 
any of a dozen sliders. The slider options are the same 
as for the Adjustment Brush tool.

To adjust an area of a photo using the 
Graduated Filter tool:

1. After adjusting your photo via the Basic and 
Tone Curve tabs,A choose the Graduated Filter
tool (G). The sliders for the tool display in the 
right panel.

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3. To define where the filter edits will be applied, 
Shift-drag over an area in the photo, beginning 
from the location where you want the adjustment 
to be strongest. The filter will be applied fully at 
the green dashed border of the overlay, gradually 
diminishing to nil at the red dashed border. Note: 
If you want to draw the overlay on a diagonal, 
don’t hold down Shift while dragging.

4. Do either or both of the following:

Use the Temperature and/or Tint slider to make 
the filtered area warmer or cooler.

Use other sliders to adjust such characteristics as 
the exposure, sharpness, or noise in the filtered
area (A–C, next page).

5. To redisplay the main tabs, press H (for the Hand 
tool).

➤ At any time, you can lengthen or shorten the filter 
overlay by dragging or Shift-dragging the green 
or red dot. To reposition the whole overlay, drag 
the line that connects the two dots. 

➤ To apply a separate overlay to another area of 
the photo, click New, then repeat steps 2–4. If 
you want to clone an overlay, hold down Ctrl-Alt/
Cmd-Option and drag the dashed line that 
connects the two pins; or right-click a selected 
overlay and choose Duplicate from the context 
menu, then move the duplicate overlay.★

➤ To hide the filter overlay, uncheck Overlay or 
press V. 

➤ To remove a filter overlay, right-click a selected 
pin then choose Delete from the context menu; 
or hold down Alt/Option and click the overlay 
(note the scissors pointer);★ or click the overlay, 
then press Backspace/Delete.

A Despite our applying Basic and Tone Curve adjustments, the sky in 
this photo looks overexposed (washed out).

EDITING A GRADUATED OR RADIAL 
FILTER MASK WITH A BRUSH★
➤ Create or select a filter overlay. Click 
the Brush button at the top of the panel 
(Shift-K) to display brush options, then click 
the Brush + (add to) or Brush – (erase from) 
button. Press [ or ] to size the brush, then 
apply strokes in the preview. (You can also 
toggle the plus and minus buttons for the 
brush by holding down Alt/Option.) If you 
want to choose different sizes for the plus 
and minus functions of the brush, check 
Separate Eraser Size on the panel menu.

➤ In the panel, you can set the Feather
value to control how much the brush edits 
fade into surrounding areas, and the Flow
value to control the amount of adjustment. 
Check Auto Mask (M) to mask only the areas 
that match the first color area the brush 
touches (see also the sidebar on page 77). 

➤ To remove all manual brush strokes from 
the currently selected overlay, click Clear.
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C In the final image, the adjustment is strongest in the sky, fading to nil in the upper 
part of the ground.

A After zeroing out the sliders for the Graduated Filter tool, we Shift-dragged 
downward in the photo (as shown by the arrow above), then chose slider settings 
to darken the exposure within the overlay area. 

B To add more blue to the upper area of 
sky, we lowered the Temperature value.



88 Chapter 4

Using the Radial Filter tool
With the Radial Filter tool, you define an elliptical area 
with an overlay, then apply adjustments via sliders to 
the area either inside or outside the overlay.

To darken an area of a photo via the 
Radial Filter tool:

1. After adjusting your photo via the Basic and Tone 
Curve tabs,A click the Radial Filter tool (J). The 
sliders for the tool display.

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click. At the 
bottom of the panel, click Effect: Outside or Inside
to control where the filter effect will occur relative 
to the overlay you will draw in the next step.

3. Drag over an area in the photo to produce an 
overlay.B If you want to reposition the overlay as 
you create it, drag with the Spacebar held down. 

4. Use any of the sliders to adjust the filtered area 
(A–C, next page). If the Effect setting is Outside, 
the adjustment will be at full strength outside the 
overlay, then diminish gradually to no adjustment 
at the dashed border. If the Effect setting is Inside, 
the adjustment will be at full strength at the 
center of the overlay and diminish gradually to 
no adjustment at the dashed border.

A Although the exposure in this photo is well bal-
anced, we want to spotlight the spa products more.

B We zeroed out the sliders for the Radial Filter tool, then dragged in the preview to create an overlay.
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5. To control how gradual the adjustment is at the 
edge of the overlay, use the Feather slider.

6. To hide the overlay(s) to gauge the adjustment, 
uncheck Overlay or press V. Redisplay the overlay 
for the next step.

7. To edit the overlay, do any of the following (all 
optional):

To reposition the overlay, drag inside it. 

To reshape the overlay, drag one of its handles.

To resize the overlay, Shift-drag a handle. 

To swap the adjustment from Outside to Inside 
the overlay, or vice versa, click the unselected 
Effect button or press X. 

8. Optional: To add another overlay, click New, then 
follow steps 2–7. To clone an overlay, hold down 

Ctrl-Alt/Cmd-Option and drag its center pin; or 
right-click the pin and choose Duplicate from the 
context menu, then drag the new pin.★ Note: 
Adjustments are cumulative where overlays over-
lap; to edit adjustment settings, click a pin first. 

9. To redisplay the main tabs, press H (Hand tool).

➤ To delete an overlay, select its center pin, then 
right-click the pin and choose Delete from the 
context menu; or hold down Alt/Option and click 
the pin (scissors pointer);★or click the pin, then 
press Backspace/Delete.

➤ To expand an overlay to the edges of a photo, 
double-click inside it; or to do this when creating 
a new overlay, double-click in the preview. 

A We used the first four sliders to darken the filtered 
area and the Clarity and Sharpness sliders to soften the 
image details.

B To make the lighting in the darkened 
areas cooler, we reduced the Temperature 
value (added blue).

C The tonal, tempera-
ture, and sharpness 

adjustments helped to 
accentuate the candle, 
soap, and white bottle.

EDIT THE MASK 
WITH A BRUSH
To edit a Radial 
Filter mask with a 
brush, follow the 
steps in the side-
bar on page 86.
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Using the Spot Removal tool
Use the Spot Removal tool to remove imperfections 
from a photo, such as spots caused by dust on the 
camera lens, blemishes in a portrait, or insects on 
flowers. You can let Camera Raw locate a source area 
for the repair automatically, or you can choose a 
source area.

The Spot Removal tool does an improved job of 
locating a source area automatically, especially when 
used to heal nonsmooth textures (Adobe mentions 
bark, rocks, and foliage as examples of textures in 
which healing results are improved). Also, if you use 
this tool on a photo that you cropped in Camera Raw, 
the tool will look for source areas within the crop 
boundary first.★
To remove blemishes or spots:

1. Choose the Spot Removal tool (B).

2. Zoom in on an area to be repaired.

3. Press [ or ] to size the brush cursor, then do one of 
the following:

Ctrl-Alt-drag/Cmd-Option-drag outward from the 
center of a blemish to create and scale a target 
circle A; or click a blemish; or if you want to con-
trol which area Camera Raw uses as the source, 
Ctrl-drag/Cmd-drag from the target area to the 
desired source area. When you release the mouse, a 
red dashed circle surrounds the target region and 
a green dashed circle surrounds the source area.B
Drag across a blemish to create a target region.
When you release the mouse, a border with a red 
pin surrounds the target region and a border with 
a green pin surrounds a source region.C–E

A With the Spot Removal tool, we 
held down Ctrl-Alt/Cmd-Option and 
dragged to create a target circle 
around a blemish.

B The tool created a linked source 
circle in a similar area and repaired 
the blemish. 

E The line is eliminated from the leaf.

D The tool created a source 
region and two pins.

C To remove an imperfection 
from a leaf, we’re dragging to 
create a target region.
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➤ To display a black-and-white version of the 
photo to help you pinpoint dust spots or other 
irregularities, check Visualize Spots (Y). Adjust 
the black-to-white threshold via the slider. 
Press Y to return to the normal display.

4. Optional: To soften the transition between the cur-
rent target area and surrounding areas, adjust the 
Feather value.A–C Or to adjust the Feather value 
interactively (within the current size of the brush 
cursor), with Shift and right-click held down, drag 
horizontally in the preview. The new Feather value 
will display within the selected target area. The 
Feather value is sticky, meaning the current value 
will persist for future editing sessions until you 
change it.★

5. From the Type menu, choose Heal to blend source 
pixels into the texture and luminosity values of the 
target pixels (often the best choice), or Clone to 
copy the source pixels exactly without any healing. 

Optional: To cycle through alternative source 
locations that Camera Raw detects, press (and 
keeping pressing) /.

6. To hide all regions and circles at any time in 
order to judge the Spot Removal results, uncheck 
Overlay (V). Recheck it for the remaining steps.

7. Select a target or source region by clicking its pin, 
or select a circle by clicking inside it, then do any 
of the following optional steps:

To reposition a region or circle, drag inside it.

To control the opacity of the repair, change the 
Opacity value in the panel.

To resize a pair of target and source circles (not 
irregular-shaped regions), drag the dashed border.

To add to an existing region (or to convert a circle 
to a region), position the pointer just outside it, 
then hold down Shift and click or drag.

8. Optional: Create more regions or circles to correct 
other blemishes. 

To remove a pair of circles or regions, hold down 
Alt/Option and click in the target or source area; 
or to delete multiple circles and/or regions, Alt/
Option drag a marquee across them; or to remove 
all Spot Removal circles and regions, click Clear All.

9. To redisplay the main tabs, press H (Hand tool).

➤ To redisplay the current Spot Removal overlays at 
any time, choose the tool again (press B).

B Using the Spot Removal tool, we dragged outward from 
the center of the shed. With the Feather value for the tool 
set to 100%, the healing is fading around the rim of the cir-
cle, and sections of the original background aren‘t replaced.

C We changed the Feather slider for the tool to 10%. Now 
the shed is more fully replaced with tree pixels, with mini-
mal fading along the rim of the target region.

A The shed in this photo is a distracting element.
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Saving and applying Camera Raw 
settings
After carefully choosing custom settings for a photo in 
Camera Raw, you’ll be glad to know that you can save 
those settings as a preset and then apply the preset to 
other photos that need the same or similar corrections. 

To save Camera Raw settings as a preset:

Method 1 (Camera Raw Settings menu)

1. With your corrected photo open in Camera Raw, 
choose Save Settings from the Camera Raw 
Settings menu.

2. The Save Settings dialog opens.A
3. Choose Subset: All Settings, then check the catego-

ries of settings you want saved in the preset. If you 
want to filter which boxes are checked for a subset, 
choose a tab name from the Subset menu, then 
check/uncheck boxes. For any menu choice, you can
also click Check All or Check None; or to select one 
box exclusively, hold down Alt/Option and click it.★

4. Click Save. A different Save Settings dialog opens 
(yes, it’s confusing that the two dialogs have the 
same name). Enter a name (preferably one that 
describes the function of the preset), keep the 
location as the Settings folder, then click Save.

5. The saved settings preset is now available in the 
Presets tab for any open photo.

Method 2 (Presets tab)

1. With your corrected photo open in Camera Raw, 
click the Presets tab, then click the New Preset
button.

2. In the New Preset dialog, enter a name for the 
preset. Follow step 3, above.

3. Click OK. Your new preset is now available in the 
Presets tab for any open photo.

➤ To delete a user-saved preset, click the preset 
name, then click the Delete button.

You can apply a user-defined preset (saved collec-
tion of settings) to a single photo via Camera Raw 
(see below), to multiple photos via Bridge (see the 
following page), or to multiple thumbnails via the 
Synchronize option in Camera Raw (see page 94).

To apply a Camera Raw preset to a photo:

With a photo open in Camera Raw, click the 
Presets tab,  then click a preset name.

➤ You can also apply a preset via the Apply Preset 
submenu on the Camera Raw Settings menu.

A In the Save Settings dialog, check which categories of 
custom Camera Raw settings are to be saved in a preset.

TAKING SNAPSHOTS OF YOUR CR SETTINGS
A snapshot is a record of the current Camera Raw 
settings that you have chosen for a photo. By saving 
snapshots of your photo periodically while editing 
it, you preserve the option to restore the photo 
to those earlier settings. Unlike snapshots on the 
History panel in Photoshop, snapshots save with 
the Camera Raw file. Click the Snapshots tab,
then click the New Snapshot button. In the New 
Snapshot dialog, enter a name, then click OK. To 
restore the photo to a snapshot at any time, click a 
snapshot name in the Snapshots tab. (For other ways 
to restore Camera Raw settings, see pages 61–62.) 

➤ To update an existing snapshot with the current 
settings, right-click the snapshot listing and choose 
Update with Current Settings from the context menu.
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The settings presets that you save in the Presets tab of 
the Camera Raw dialog can also be applied to multiple 
photos via the Develop Settings submenu in Bridge. In 
fact, as a strategy, you could save separate presets for 
settings in individual Camera Raw tabs and then assign 
them to multiple photos in succession (e.g., a preset for 
the Basic tab first, then a preset for the Tone Curve tab, 
and so on). If you haven’t saved the needed settings 
as presets, a quick alternative method is to copy and 
paste all the current settings from one photo into one 
or more other photos.

To apply Camera Raw settings to multiple 
photos via Bridge: 

Method 1 (apply a preset)

1. In Bridge, Ctrl-click/Cmd-click multiple photo 
thumbnails (or Shift, then Shift-click a consecutive 
series of thumbnails).

2. To apply settings, from the Edit > Develop Settings
submenu, choose a preset; or right-click a selected 
thumbnail and choose a preset from the Develop 
Settings submenu on the context menu.A Choose 
additional presets, if needed.

Method 2 (copy and paste settings from a photo)

1. Click the thumbnail for a photo that has the 
desired settings, then choose Edit > Develop 
Settings > Copy Camera Raw Settings (Ctrl-Alt-C/
Cmd-Option-C), or right-click the selected thumb-
nail and choose Develop Settings > Copy Settings  
from the context menu.

2. Click another thumbnail (or Ctrl-click/Cmd-click 
multiple thumbnails), then choose Edit > Develop 
Settings > Paste Camera Raw Settings (Ctrl-Alt-V/
Cmd-Option-V), or right-click the selected thumb-
nail and choose Develop Settings > Paste Settings 
from the context menu.

3. The Paste Camera Raw Settings dialog opens. 
Uncheck any settings you don’t want to paste; or 
choose a tab name from the Subset menu, then 
remove or add any check marks; or to select one 
box exclusively, hold down Alt/Option and click 
it.★ Click OK.

➤ To remove all Camera Raw settings from a selected 
photo thumbnail in Bridge, choose Edit > Develop 
Settings > Clear Settings or right-click the thumb-
nail and choose Develop Settings > Clear Settings 
from the context menu. 

A Using commands on the Develop Settings submenu in Bridge, you can apply one or more saved settings presets to multiple 
selected thumbnails, or copy and paste the current settings from one thumbnail to other thumbnails.
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Synchronizing Camera Raw 
settings
When you open multiple photos into Camera Raw, 
they are represented by thumbnails in a panel on the 
left side of the dialog. After adjusting one photo, you 
can click Synchronize to apply those settings to one 
or more of the other photos. Because it’s unlikely that 
every single adjustment needed for one photo will be 
perfectly suited to all the others (even photos taken 
during the same shoot), a more practical approach is to 
adjust subsets of the grouping. For instance, you could 
apply a settings preset or some Basic tab adjustments 
to one photo (say, to correct the white balance and 
exposure), apply those settings to most or all of the 
other photos, then select incrementally smaller num-
bers of photos and apply more targeted or specialty 
adjustments.

To synchronize the Camera Raw settings 
among multiple photos:

1. In Bridge, select two or more photo thumbnails, 
preferably ones that were shot under the same 
lighting conditions and that require the same kind 
of correction (for the most accurate and consistent 
corrections, select all raw files or all JPEG files). 
Double-click one of the selected thumbnails.

2. In the filmstrip panel on the left side of the Camera 
Raw dialog, click one of the thumbnails.A

3. Make the needed adjustments to the selected 
image (including cropping, if you want to crop all 
the images in exactly the same way). You can apply 
adjustments via the tabs or tools or by clicking a 
preset in the Presets tab.

4. Click Select All at the top of the filmstrip panel or 
Ctrl-click/Cmd-click the thumbnails to which you 
want to apply corrections, then click Synchronize.

5. The Synchronize dialog opens (it looks like the 
Save Settings dialog, which is shown on page 92).
Check only the settings you want to apply to all 
the selected thumbnails; or choose a category 
from the Synchronize menu, then remove or add 
any check marks. Click OK.

➤ To cycle through the photos in the filmstrip panel, 
click the left or right arrowhead below the preview 
(in the lower right). If more than one thumbnail 
is selected, Camera Raw will cycle among only the 
selected photos.

A We opened four photos into Camera Raw. The thumbnails 
for the images display in the filmstrip panel on the left side of 
the dialog.

WHERE CR SETTINGS ARE SAVED
Depending on the current setting on the Save Image 
Settings In menu in the Camera Raw Preferences dia-
log (Ctrl-K/Cmd-K), settings for raw photos (not JPEGs) 
are saved either in the internal Camera Raw Database
on your system or as hidden Sidecar .xmp Files in the 
same folder as the raw files. Don’t confuse these files 
with the user-settings files that you create via the Save 
Settings command.
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Converting, opening, and saving Camera Raw files
Still with us? At long last, you get to open your Camera 
Raw file into Photoshop.

To open a photo from Camera Raw into 
Photoshop:

1. After applying adjustments to your photo in 
Camera Raw, click Open Image; or if you opened 
and corrected multiple files, select them on the 
left side of the dialog, then click Open Images.

2. The photo appears as the Background in a new 
Photoshop document (or documents). Save the 
file(s) in the Photoshop (PSD) format. 

Note: If Open in Photoshop as Smart Objects is 
checked in the Workflow Options dialog (see step 
10 on page 58), the Open Image button is labeled 
Open Object and a photo opens as a Smart Object 
in a new Photoshop document. To learn about 
Smart Objects, see pages 264–275 (to edit the 
Camera Raw settings of a Smart Object, see page 
268). If the workflow option is off, you can convert 
the Open Image button to Open Object by hold-
ing down Shift.

➤ To close the Camera Raw dialog without open-
ing your file, but save your settings to the file as 
instructions, click Done. The settings will redisplay 
if you reopen the file in Camera Raw.

If desired, you can open a copy of a Camera Raw file with 
its current (custom) settings into Photoshop without 
changing the settings in the original raw or JPEG file.

To open a copy of a Camera Raw file:

In the Camera Raw dialog, hold down Alt/Option 
and click Open Copy (Open Image or Open Object 
becomes Open Copy).

Settings in the Workflow Options dialog are assigned 
automatically to all photos that you open into Camera 
Raw (see pages 58-60). If you want to convert and save 
a copy of an individual photo in the Digital Negative 
(DNG), JPEG, TIFF, or Photoshop (PSD) format using 
custom file naming, format, color space, sizing, or 
sharpening settings instead, use the Save Options 
dialog, as described below. New Color Space, Image 
Sizing, and Preset features, found in the Workflow 
Options dialog, are also available in the Save Options 
dialog.★

When you save a copy of a photo in the Digital 
Negative format via Save Options, the Camera Raw 
settings it inherits from the original file remain acces-
sible and editable in Camera Raw. See also the sidebar 
on this page.

When you save a photo in the JPEG, TIFF, or PSD 
format via Save Options, the Camera Raw settings 
are applied to the copy of the photo permanently. 
Although you can open and edit the resulting JPEG or 
TIFF file in Camera Raw, you will see that the sliders are 
reset to their default values. PSD files can’t be opened 
into Camera Raw. 

Note: Settings that you choose in the Save Options 
dialog are independent of — and have no effect on —
the settings in the Workflow Options dialog. 

To save a copy of a Camera Raw file in the 
DNG, JPEG, TIFF, or PSD format:

1. Open and adjust a photo in Camera Raw, then 
in the lower-left corner of the dialog, click Save 
Image.

2. The Save Options dialog opens (A, next page). For 
the Destination, choose Save in Same Location or 
Save in New Location. For the latter, choose a loca-
tion in the Select Destination Folder dialog, then 
click Select. 

ARCHIVING PHOTOS AS DNG FILES
Photographs capture unrepeatable moments, and 
archiving them is both a priority and a concern for 
photographers. Ideally, there would be one standard 
file format for digital photos that photographers 
could depend on with confidence, knowing their 
photos will be stable and accessible for the foresee-
able future. At the present time, each camera maker 
uses a unique, proprietary format for their raw files. 
Should a maker discontinue its format, raw photos 
from their cameras might become unreadable by 
Photoshop or other image-editing applications.

Luckily, DNG (short for Digital Negative), a format 
developed by Adobe, preserves all the raw, unpro-
cessed pixel information that is recorded by the 
camera. The coding for the DNG format is nonpropri-
etary (open standard), meaning that it is accessible to 
all interested companies. DNG may be the long-term 
solution that photographers will eventually come to 
rely on — provided it is adopted as the standard by a 
majority of camera and software manufacturers.

Continued on the following page
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3. Under File Naming, choose a naming or num-
bering convention from the menu or enter a file 
name. If desired, you can also choose an addi-
tional naming or numbering convention from 
the adjacent menu. 

4. Choose a Format of Digital Negative, JPEG, TIFF, 
or Photoshop, then choose related options. For 
instance, if you cropped the photo in Camera 
Raw and then choose the Photoshop format 
here, you will need to decide whether to check 
Preserve Cropped Pixels.

5. For a photo in the JPEG, TIFF, or Photoshop 
format, choose an option from the Metadata
menu to control what metadata will be saved 
with the file. And via the Remove Location Info 
check box, control whether you want location 
information for the file to be preserved. 

6. For a photo in the JPEG, TIFF, or Photoshop 
format, you can choose options under Color 
Space,★ Image Sizing,★ and Output 
Sharpening. For Color Space, see step 3 on page 
58; for Image Sizing, see page 60; and for Output 
Sharpening, see step 9 on page 58.

7. Optional: To save the current dialog settings 
as a preset for future use on any photo, from 
the Preset menu,★choose New Save Options 
Preset. In the dialog, enter a name, then click OK.

8. Click Save. A copy of the file appears in the des-
ignated location. The original file, with its current 
settings, remains open in Camera Raw.

➤ User-created presets are available on the Preset 
menu. Once you choose a preset, the menu also 
provides Delete [preset name] and Rename 
[preset name] commands.

➤ When you assign a color space and an intent 
to a photo via the Workflow Options dialog, 
those settings display as a soft proof in the main 
Camera Raw dialog, whereas when you choose 
color space and an intent options in the Save 
Options dialog, no soft proof displays.

A In the Save Options dialog, choose Destination, File 
Naming, Format, Color Space, Image Sizing, and Output 
Sharpening settings. 
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Unless noted otherwise, the listings in this index pertain to Photoshop.
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redocking floating panels into, 107
resizing, 98

Art History tool, 115

artistic borders, 442–443

asset files
bit depth, 491–492
creating, 490–493
default location, 491
generating from layers or layer 

groups, 492
quality settings, 491–492
thumbnail display, 493
See also image assets

Assign Profile dialog, 12

audio clips, 456

Auto Color Correction Options dialog,
234–235

Auto Resolution dialog, 138

Auto-Align Layers dialog, 284

B
Background

converting into layer, 152
converting layer to, 152
customizing, 104
deleting selection from, 170
duplicating, 298
filling selection on, 170
moving upward on list, 154
new document, choosing for, 15

Background color
choosing, 203, 204, 207
filters that use, 358

Background Eraser tool, 115

baseline shift, 379

Basic blending modes, 209

Basic tab (Camera Raw)
Clipping Warning buttons, 64
color saturation adjustments, 67
contrast adjustments, 64–66
defined, 61, 63
edge contrast adjustments, 67
exposure adjustments, 64–66, 276, 

277
histogram tonal edits, 64
using, 63–67
white balance adjustments, 63

Batch dialog, 430–431

Batch Rename dialog, 44

Bevel effect, 392–393

bit depth
changing, 360
Generator default, 491–492

photoshop channels and, 2

Bitmap mode, 4

Black & White adjustment layer
grayscale conversion via, 246–248
Targeted Adjustment tool, 246
tints, 246, 248

blemishes, removing
Spot Healing Brush tool, 313
Spot Removal tool (Camera Raw), 

90–91

blending layers
Blending Options, 346–347
modified with original one, 344
opacity, 345

blending modes
brush, 290
categories, 209
choosing, 209–210
cycling through, 210
fill layer, 211–213
filters and, 366
list of, 209

Blending Options
for Layers, 346–347
for Smart Filters, 361

Blur Gallery
applying filters in, 325–333
blurring adjustment, 326
Bokeh feature, 332
defined, 325
Field Blur filter, 325, 326, 327
filter masks, 333
filter pins, 326
Iris Blur filter, 325, 326, 328
Path Blur filter, 330–331
selections with filters, 326
Spin Blur filter, 325, 326, 331
Tilt-Shift filter, 325, 326, 329

Blur tool, 115

bokeh options in Blur Gallery, 332

Bridge
cache, exporting, 48
collections, 46–47
Collections panel, 26, 46–47
Content panel, 26, 29, 30, 37
custom, 38
deleting, 38
Favorites panel, 26, 29, 46
file searches, 45
Filter Items by Rating menu, 41
Filter panel, 26
Folders panel, 26, 29

image previews in, 29–32
keywords, 38–39
Keywords panel, 26, 38–39
launching, 23
loupe

moving, 32
preference settings for, 470
using, 31

metadata display, 37
Metadata panel, 26, 39
Metadata placard, 29
navigation controls, 29
Open Recent File menu, 33
opening files from, 33–35
Options for Thumbnail Quality and 

Preview Generation menu, 30
panes and panels, configuring, 36
Photo Downloader, 24–25
Preview panel, 26
Refine menu, 32
resetting, 38
Reveal Recent File or Go to Recent 

Folder menu, 33
Review mode, 32, 40
saving, 38
thumbnails, 29, 30, 36, 40–43, 47
uses, 23
View Content buttons, 37
window customization, 36–37
window features, 26–27
window illustration, 27
workspaces

changing, 28
choosing, 28
default, 26
deleting, 38
predefined, restoring, 38
resetting, 38
saving, 38

Brightness/Contrast adjustments, 232

bristle brushes, 296–297

Brush panel
Airbrush tips, 294
Angle option, 290
Brush Pose option, 296
Brush Projection option, 292
Brush Tip Shape option, 290, 293, 294
Color Dynamics option, 292
Create New Brush button, 293
customizing brushes via, 290–293
displaying, 117
Erodible Point tips, 293–294
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Hardness option, 291
illustrated, 117, 291
Live Brush Tip Preview button, 293
New Brush button, 130
quick access to, 295
Roundness option, 291
Scattering options, 292
Shape Dynamics option, 292
Size option, 290
Spacing option, 291
Texture option, 292–293
Transfer option, 293
uses, 117

Brush Preset picker, 289, 306–307

brush presets
deleting, 295
identifying types of, 128
loading, 295
managing, 295
modified indication, 295
names, viewing, 299
resetting, 295
saving, 131, 295
settings, 295
tools that use, 128

Brush Presets panel
illustrated, 118
Live Brush Tip Preview button, 293, 

295
Open Preset Manager button, 133, 

295
quick access to, 295
saving brushes from, 131

brush strokes, recording, 428

Brush tool
Airbrush tip, 294
choosing settings for, 128–129
creating selections with, 189
defined, 114
editing layer masks with, 280
Erodible tip, 293–294
in hiding filter effect, 362
Options bar, 188, 191, 227, 290
painting with, 289–294
reshaping layer masks with, 191, 280
reshaping selections with, 188
in turning photos into drawings, 368

brushes
blending mode, 290
bristle, 296–297
customizing, 130, 290–294
diameter, 129, 278, 306

editing graduated or radial filter 
mask with, 86–87

flow rate, 290
hardness, 128, 129
opacity, 129, 290
roundness, 128
saving, 295
settings, choosing, 128
size, changing, 129, 290
tips, 290–294

Burn tool, 115

C
cache (Bridge), 48

Cache preferences (Bridge), 472

calibration, display, 6

Camera Calibration tab (Camera 
Raw), 61

Camera Raw
Adjustment Brush tool, 55, 74–78
advantages to using, 49
Before/After Views menu, 61
Basic tab, 61, 63–67
Camera Calibration tab, 61
Crop tool, 55, 56
default settings, restoring, 61
Detail tab, 61, 70–71
dialog illustration, 53
editing layers in, 54
Effects tab, 61, 84–85
filters, 54
Gamut Warning button, 59
Graduated Filter tool, 55, 86–87
HDR file processing in, 253
host selection for, 52
HSL/Grayscale tab, 61, 72–73
Lens Corrections tab, 61, 80–83
luminance, reducing, 70
noise reduction, 50
opening files from, as embedded 

Smart Objects, 265
opening layers in, 54
opening photos into, 53
presets, applying, 92
presets, saving, 92
Presets tab, 61
previews, 50, 55, 61
Radial Filter tool, 88–89
reasons for using, 49–51
Red Eye Removal tool, 55
scrubby-sliders, 61
settings, applying to multiple 

photos, 93

settings, removing, 93
settings, save location, 94
settings, saving as preset, 92
settings, synchronizing, 94
Settings menu, 62, 92
shadow clipping, 66
sharpening, 50, 70
Snapshots, 61, 92
Split Toning tab, 61, 79
Spot Removal tool, 55, 90–91
Straighten tool, 55, 57
Targeted Adjustment tool, 68–69, 73
toggling between default settings, 62
tonal redistribution, 50
Tone Curve tab, 61, 68–69
tools, 55
updating, 51
white balance, 62
White Balance tool, 55
workflow options, 58–60
zoom methods, 55

Camera Raw Filter, 54

cameras
Adobe RGB color space, 5
capturing tonal values (Camera 

Raw), 50
downloading photos from, 24–25

canvas
area, enlarging with Crop tool, 146
pixels outside of, 257
size, changing, 140
view, rotating, 103

Canvas Size dialog, 140

channels
alpha, 182, 188, 428
core, 2
Curves adjustment layer, 244
defined, 2
document color mode and, 3
spot color, 388

Channels panel
displaying, 2
illustrated, 118
Load Channel as Selection button, 

182
New Spot Channel command, 388
Photoshop color modes and, 2–4
Save Selection as Channel button, 182

Character panel
Baseline Shift controls, 379
Color swatch, 373
displaying, 119
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East Asian Feaures, 371, 469
Font Family menu, 373
Font Size menu, 376
Font Style menu, 373
illustrated, 119, 369
Kerning menu, 377
Leading controls, 378
Middle Eastern Features, 371, 469
OpenType buttons, 379
resetting, 377
showing, 372
South Asian features, 469
Toggle Typekit Fonts button, 374
Tracking controls, 377

Character Style Options dialog, 382

Character Styles panel
illustrated, 119
Load Character Styles command, 383
Load Default Type Styles command, 

383
New Character Style button, 381
Redefine Character Style by Merging 

Override button, 382
Save Default Type Styles command, 

383

Choose Package Destination dialog,
494

Clipboard
New dialog and, 16
with Paste command, 256
with Paste Into command, 258
purging, 256
using, 255–258

clipping
adjustments, 225
high-contrast display of, 242
layers, 343–344

clipping masks
creating, 343–344
grouped layers in, 344
releasing, 344
releasing layers from, 344
using, 343–344

Clone Source panel
clone source overlay transformations, 

283
illustrated, 120
using, 282

Clone Stamp tool
defined, 114
using, 318–319

cloning, retouching by, 318–319

CMYK Color mode
channels, 3
conversion, 483
defined, 3, 4
output, final corrections in, 221
soft-proofing, 475
working space, 483

CMYK color model
in color selection, 204
defined, 2

collections (Bridge)
adding to Favorites panel, 46
contents, displaying, 46
creating and using, 46–47
deleting, 46
naming, 46
relinking missing file to, 47
from search results, 45
Smart, creating and editing, 46
standard, adding/removing 

thumbnails, 47
standard, creating, 47
types of, 46

Collections panel (Bridge)
in creating and using collections, 

46–47
defined, 26

Color Balance adjustments, 236–237

color corrections
auto, 234–235
Color Balance adjustment, 236–237
Curves adjustment, 242–245
display calibration and, 221
Hue/Saturation adjustments, 238
Photo Filter adjustments, 233
Vibrance adjustment, 239–241

color depth (Camera Raw), 58

Color Libraries dialog, 203, 205

color management
benefits of using, 5
Color Handling menu, 478, 479
color modes and, 3–4
display calibration, 6
introduction to, 5–6
Output options, 480
Photoshop, benefits of, 479
policies, customizing, 10
settings, 478
turning off for printer, 481–482

color modes, document
Bitmap, 4
changing, 360

CMYK Color, 3, 4, 221
conversions, 3
Grayscale, 4
Indexed Color, 4
Lab Color, 4
RGB Color, 3, 4, 221, 473
selecting, 15
Smart Filters and, 360

color noise reduction (Camera Raw), 
70–71

Color panel
choosing colors with, 203
illustrated, 120
out-of-gamut alert, 206

Color Picker
choosing colors with, 203
HUD, 190
opening, 120
out-of-gamut alert, 206
replacement color, 373

color profiles
assigning, 35
changing, 12
converting, 12
defined, 5
mismatch, 10
missing, 10, 35
removing, 12
selecting, 15
for soft proof, 474–475

Color Range command, 176–178

Color Replacement tool
defined, 114
in red-eye removal, 309
using, 306–307

Color Sampler tool, 114

Color Sampler tool (Camera Raw), 55

color settings
choosing, 7, 8
installing, 11
saving, 11
synchronizing, 9

Color Settings dialog
accessing, 7, 8, 10, 11
in color policy customization, 10
color space selection in, 8
Missing Profiles option, 10
Profile Mismatches option, 10
saving color settings in, 11
Settings menu, 8, 483
Working Spaces settings, 8, 483

Color Settings dialog (Bridge), 9
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color spaces
Adobe RGB, 5, 8
assigning via Workflow Options 

dialog, 96
choosing, 7–8
defined, 5
setting, 5

color-blind viewer design, 213

color(s)
Background, 203, 204
basic methods for choosing, 203–204
blending modes, 209–210
as building blocks, 2
choosing, 203–204
choosing from color libraries, 205
choosing from Swatches panel, 207
choosing with Color Picker, 203, 

204–205
continuous tones, 2
copying as hexadecimals, 208
depth (Camera Raw), 60
desaturating, 240, 241
fill layers, 211
Foreground, 203, 204
layer, assigning, 160, 161
layer mask, 191
process, 205
proofing, 474–475
rendering intents, 475, 478
replacing, 304–305
restoring, selectively, 241
sampling, 203, 208
spot, 204, 205
type, 373

commands (action)
adding, 434
adding modal controls to, 435
deleting, 438
duplicating within/between 

actions, 434
settings, changing, 438

commercial printing
file preparation for, 475, 483
workflow for, 483

Comparative blending modes, 209

Component blending modes, 209

Conditional Action dialog, 436–437

contact sheets, 445

Content panel (Bridge)
defined, 26
in image display, 29
metadata display in, 37

search results, 45
thumbnail display, 30

Content-Aware fill, 321

Content-Aware Move tool
defined, 114
moving/reshaping with, 322–323

Content-Aware scaling, 350–351

context menus
Layers panel, 155
using, 112

continuous tones, 2

contrast
auto adjustment, 235
Brightness/Contrast adjustment, 232
Curves adjustment, 242–243
Levels adjustment, 230–231

contrast adjustments (Camera Raw)
adjustments, 64–66
edge, 67

Contrast blending modes, 209

Convert Point tool, 115

Convert to Profile dialog, 12

converting
Background to layer, 152
color profiles, 12
layer to Background, 152
layer to grayscale, 246–248
layers to Smart Objects, 264
RGB files to CMYK files, 483
shape layers to pixel layers, 409
type, paragraph to point/point to 

paragraph, 376
vector masks to layer masks, 417

copying
action commands, 434
colors as hexadecimals, 208
imagery to new layer, 257
layer effects, 398
layer masks, 194
layer settings, 257
layer styles, 401
layers, 165
layers, Smart Guides and, 286
pasting, 256
path listing, 425
selection borders, 171
selections, 256
shapes, 413
Smart Filters, 361
Smart Objects, 269
stroke and fill attributes on 

shapes, 409

text styles, between documents, 383
vector masks, 416

Count tool, 114

Creative Cloud
application adherence to ICC 

profiles, 5
downloading settings from, 496
individual file management, 498
launching, 497
missing fonts and, 34
preferences, 461
sharing, renaming, moving, or 

archiving files via, 497
signing out of, 498
storage amount, checking, 497
syncing fonts and, 374
syncing Photoshop settings via, 

495–496
syncing preferences via, 457
syncing presets with, 130
uploading files to, 497
uploading settings from first 

computer to, 495–496

crop box
choosing options for, 142
cropping to, 144
guide lines within, 142
repositioning images within, 142
resizing, 141, 144
restoring, 141
selection in defining, 145

Crop tool
Camera Raw, 55, 56
crop box reset, 142
cropping image, 141
cropping multiple images, 144–146
cropping to aspect ratio, 144
cropping to crop box, 144
cropping to size and resolution, 144
defined, 114
enlarging canvas area, 146
overlay options, 142
preview options, 142
recording use of, 431
saving settings as preset, 145
shield options, 142
sticky settings, 145
straightening images with, 147

cropping
to aspect ratio, 144
to crop box, 144
manually, 141
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nondestructive, 142
photos (Camera Raw), 56
to specific size and resolution, 144
trim areas, 146

.csf files, 11

Cursors preferences, 113, 313, 466

Curves adjustment layer
applying, 242–245
color correction with, 244
in darkening midtones, 224
options, 242–243
Targeted Adjustment tool, 242, 244
tonal adjustments with, 242–243
See also adjustment layers

Curves Display Options dialog, 242

Custom Shape tool
creating shape layers with, 406
defined, 115

Customize Proof Condition dialog, 474

D
Darken blending mode, 209, 316–317

Delete Anchor tool, 115

Delete Workspace dialog, 109

desaturation, 240–241

Detail tab (Camera Raw)
defined, 61
using, 70–71

DIC Color Guide, 205

Diffuse Glow filter, 365

Digimarc, 444

dimensions
document, 135–139
selection, 168
Web output, 13, 16

Direct Selection tool, 115, 412, 424

displays, calibrating, 6, 221

distortion
geometric, 80–83
layer, 348–349
Liquify filter, 352–354
Warp, 356
See also transformations

distributing layers, 281

DNG files, 95

docks, panel
collapsing, 106
creating, 107
floating, 107
hidden, displaying, 105
reconfiguring, 106–107

document windows
displaying one image in two, 100
docking, 99
floating, 99
multiple, rotating among, 102
multiple, scrolling/zooming in, 103
repositioning images in, 102
resizing, 100
right-clicking in, 112
selecting layers or layer groups in, 

153, 262
Status bar, 21
tiling, 100

documents
blank, creating, 15–16
closing, 22
creating from history states, 202
creating from layers, 262
creating from thumbnails, 264
dimensions, 21, 135–139
dragging files into, as Smart Objects, 

266–267
flattened, 166
information, getting quickly, 21
open, displaying specs of, 16
opening as tabs, 99
pixel scale ratio, 21
presets, creating, 16
profiles, 21
resolution, 135–139
reverting to last version, 18
saving, 18–20
size, 21
state, restoring, 447
Status bar, 21
type styles, loading, 383

Dodge tool, 115

downloading photos (Bridge), 24–25

drag-copying
layers, 262–263
selections, 259–261

drawings, changing photos into, 368

Drop Shadow layer effect
in adding depth, 367
applying, 394–395
in rusted metal type, 382
transforming, 395

droplets for actions, 432

Duplicate Layer dialog, 262

duplicating
actions, 433
Background, 298

embedded Smart Objects, 269
layer comps, 446
layers and layer groups, 151
See also copying

E
Edge Reflow, 490

Edit menu
Assign Profile command, 12
Auto-Align Layers command, 284
Clear command, 258
Color Settings command, 7, 8, 10, 

305, 475, 483
Content-Aware Scale command, 

350, 351
Convert to Profile command, 12
Copy command, 256, 258
Copy Merged command, 256, 258
Cut command, 170, 256
Define Custom Shape command, 

130, 423
Define Pattern command, 130, 217
Fill command, 131, 211, 217, 227, 321
Free Transform command, 348, 349
Free Transform Path command, 348, 

425
Menus command, 108
New command, 258
Paste command, 256, 423
Paste Special command, 256, 258
Presets command, 132, 133
Purge command, 198, 256
Transform Path submenu, 425
Transform submenu

Distort command, 386, 395
Flip commands, 148
Perspective command, 386
Rotate commands, 148
Warp command, 356, 379

Edit menu (Bridge)
Color Settings command, 9
Develop Settings command, 93
Find command, 45, 46

Edit Smart Collection dialog, 46

editable type layers
creating, 370–371
defined, 124
fading, 378
filling, 384
merging, 164
preserving, 386
See also type
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Effects tab (Camera Raw)
defined, 61
grain texture application, 84
vignette application, 85

Ellipse tool, 115

Elliptical Marquee tool
in creating selections, 168
in creating vignettes, 439, 440
defined, 114
in deselection, 170
fixed ratio/dimensions selection, 168
in frame-shaped selections, 179
Options bar, 168, 439, 440

Embedded Profile Mismatch alert 
dialog, 35

embedded Smart Objects
converting layers in Photoshop files 

to, 264
converting to linked, 274
creating, 264–267
duplicates, creating, 269
duplicates, editing, 269–270
editing, 268
opening files as, 265
opening files from Camera Raw 

as, 265
pasting Adobe Illustrator art as, 266
placing/dragging files as, 266–267
replacing, 271
See also Smart Objects

Emboss layer effect, 392–393

Eraser tool
defined, 115
using, 300

Erodible Point tips, 293–294

Essential workspace (Bridge), 28

Every-Line Composer, 380

Experimental Features preferences,
469

Export/Import Presets dialog, 132

exporting
Bridge cache, 48
color swatches, 207
preset libraries, 132

exposure correction (Camera Raw)
adjustments, 64–66
Basic tab, 276, 277

exposures, combining, 276–278

Eyedropper tool
defined, 114
sampling colors with, 208

eyes, whitening, 308

F
Favorites panel (Bridge), 26, 29, 46

Field Blur filter
blurring control, 326
defined, 325
mask, using, 333
pins, 326, 327, 332
using, 327

file formats
Photoshop feature preservation, 18
in saving files, 18–20, 486–489
for Web and mobile devices, 489

File Handling preferences, 20, 462–463
Adobe Drive, 463
File Compatibility, 462
File List, 463
File Saving Options, 462
illustrated, 463

File menu
Automate submenu, 432
Browse in Bridge command, 9
Close command, 22
Exit command, 22
Generate submenu, 490, 492
New command, 15, 16
New Dialog command, 150
Open as Smart Object command, 265
Open command, 33, 484
Open Recent command, 33
Package command, 494
Place command, 484, 485
Place Embedded command, 266
Place Linked command, 272
Print command, 476
Revert command, 18, 197
Save As command, 12, 18, 20, 139, 

166, 483, 485
Save command, 18
Scripts submenu, 399

File menu (Bridge)
New Window command, 28
Open Recent command, 33

File Type Associations preferences
(Bridge), 472

files
asset, 490–493
dragging into documents as Smart 

Objects, 266–267
8-bit, 17
getting into Illustrator, 484–485
getting into InDesign, 484, 485
managing via Creative Cloud, 497–498

opening as embedded Smart Object, 
265

opening from Camera Raw as 
embedded Smart Object, 265

placing into Photoshop as Smart 
Objects, 266–267

preparing for commercial printing, 
483

resampling, 135
resolution, 13–14
saving in PDF format, 486
16-bit, 17
32-bit, 17, 21
versions, saving, 20
video, 450
ZIP, 488

files (Bridge)
assigning keywords to, 38–39
batch-renaming, 44
cache, 48
copying, 43
deleting, 43
managing, 38–39, 43–44
moving, 43
opening, 33–35
quick search, 45
renaming, 43
reopening, 33
searching for, 45

files (Camera Raw)
advantages to using, 49–51
JPEG files versus, 49, 51
opening into Photoshop, 94
previewing, 50
saving, 94
TIFF files versus, 49, 51
workflow options for, 58–59

Fill dialog, 217–218, 220, 321

fill layers
blending mode, 211–213
color, changing, 211
defined, 124
Gradient, 212–213
opacity, 211–213
Pattern, 213
with scripted patterns, 217–220
Solid Color, 184, 211

Filmstrip workspace (Bridge), 28

Filter Gallery
accessing, 358, 360
dialog illustration, 359
previews, hiding/showing, 358
using, 358–359
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filter masks
creating, 362
deactivating, 362
deleting, 362
editing, 362
gradient, 364
wiping clean, 364

Filter menu
Blur Gallery submenu

Field Blur command, 325
Iris Blur command, 325
Path Blur command, 330
Spin blur command, 325
Tilt-Shift command, 325

Blur submenu
Gaussian Blur command, 316
Surface Blur command, 315

Brush Strokes submenu, 403
Camera Raw Filter command, 54
Convert for Smart Filters 

command, 360
Filter Gallery command, 358, 360
Lens Correction command, 441
Liquify command, 352
Other submenu, 364
Sharpen submenu

Shake Reduction command, 339
Smart Sharpen command, 334
Unsharp Mask command, 337

Stylize submenu, 366, 368

Filter panel (Bridge)
defined, 26
in thumbnail display, 41

filters
adjustment layers and, 365, 366
applying, 357–359
applying as Smart Filter, 360
applying via Filter Gallery, 358–359
blending modes and, 366
Diffuse Glow, 365
effects, replacing, 358
effects, stacking position, 358
Field Blur, 325, 326, 327, 332, 333
Find Edges, 366
Foreground/Background colors, 358
Gaussian Blur, 316–317
Iris Blur, 325, 326, 328, 333
last used, reopening, 358
Lens Correction, 441
Liquify, 313, 352–355
Maximum, 364
memory problems and, 362

Minimum, 364, 366
Path Blur, 330–331, 333
preferences, 468
preview feature, 359
reapplying, 358
Shake Reduction, 339–342
Smart Sharpen, 334–336
Spatter, 403
Spin blur, 325, 326, 331, 333
Surface Blur, 315
techniques for using, 365–367
Texturizer, 367
Tilt-Shift, 325, 326, 329, 333
unavailable, 357
Unsharp Mask, 337–338
uses, 357
video clip application to, 455

Find dialog (Bridge), 45

Find Edges filter, 366

flattening
layer effects, 399
layers, 166

flipping
clone source overlay, 283
layers, 148

FOCOLTONE colors, 205

Focus Area Add tool, 180, 181

Focus Area dialog, 180–181

Focus Area Subtract tool, 181

folders (Bridge)
adding to Favorites panel, 29
copying, 43
creating, 43
current, exporting Bridge cache 

for, 48
deleting, 43
displaying contents of, 29
moving, 43
navigating to, 29
purging cache files from, 48

Folders panel (Bridge), 26, 29

fonts
family, changing, 373–374
missing fonts alert, 34
size, changing, 376
style, changing, 373–374
Typekit, 34, 374–375
vector outlines, 371

Foreground color
choosing, 203, 204, 207
filters that use, 358

Frame dialog, 218

Freeform Pen tool
defined, 115
in drawing paths, 415
using, 418

Full screen mode, 104

G
gamma, calibration, 6

Gaussian Blur filter, 316–317

General preferences, 458–459
Always Create Smart Objects When 

Placing, 266, 458
Animated Zoom, 101
Export Clipboard, 255–256, 458
History Log, 459
HUD Color Picker, 458
illustrated, 459
Image interpolation, 458
Options, 458
Resize Image During Place, 266, 272, 

458
Snap Vector Tools and Transforms to 

Pixel Grid option, 405, 458–459
Vary Round Brush Hardness Based on 

HUD Vertical Movement, 129, 458

General preferences (Bridge), 470

Generator
asset files location, 491
benefits of using, 490
bit depth, 491–492
defined, 490
enabling, 490
image asset generation, 490–493
preferences, 468
quality setting, 491–492

geometric distortion, correcting
(Camera Raw), 80–83

GIF format, for Web and mobile device 
output, 489

Golden Ratio, 142

Golden Spiral, 143

Gradient Editor dialog
illustrated, 215
opening, 214, 248
in tinting images, 248–249

Gradient Fill dialog, 131, 212, 215

Gradient fill layers
applying gradients via, 215
creating, 212–213
settings, editing, 213

Gradient Map adjustments, 248–249

Gradient Overlay layer effect, 396–397
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Gradient tool
applying gradients via, 216
defined, 115
editing layer mask via, 279–280
filter effect, 362, 364
Gradient thumbnails, 214
Options bar, 279

gradients
applying via fill layer, 212–213
applying via Gradient Overlay effect, 

396–397
applying via Gradient tool, 216
creating, 130
defined, 212
effects, complex, 215
filter mask, 364
layer mask, 279–280
loading, 212
presets, 214–215
repositioning, 397
resetting to default position, 397
saving, 131
scaling, 397

Graduated Filter tool (Camera Raw), 
55, 86–87

grayscale
converting images to, 246
converting layer to, 246–248

Grayscale mode, 4

grid
preferences, 468
showing/hiding, 288

Guides, Grid & Slices preferences,
286, 468

H
hair selection, 184–187

Hand tool
Camera Raw, 55
defined, 116
in repositioning images, 102
temporary, 102

HDR (High Dynamic Range) images
Merge to HDR Pro command, 

250–252
processing in Camera Raw, 253
producing, 250–253
shooting photos for composite, 250

HDR Toning command, 253

Healing Brush tool
defined, 114
hot spot removal, 312
using, 310–312

wrinkles, softening, 310, 311

highlights
Color Balance adjustment, 237
with Levels adjustment, 230
lightening, 243

Histogram panel
illustrated, 121
using, 228–229

History Brush tool
defined, 115
History panel with, 121
using, 301–302

History Options dialog, 196, 199

History panel
defined, 195
Delete Current State button, 198
History Brush tool with, 121
illustrated, 121
linear mode, 195, 196, 197
New Document from Current State 

button, 202
New Snapshot option, 200
nonlinear mode, 196, 197
number of states, 196
options, 195–196

history states
changing, 197
clearing, 198
deleting, 121, 198
document creation from, 202
number of, 196
purging, 198
restacking, 197
snapshots, 199–201

HKS colors, 205

Horizontal Type Mask tool, 115

Horizontal Type tool
in changing font size, 376
creating type with, 370–371
defined, 115
recoloring type with, 373
selecting type with, 372

HSB model, 206

HSL/Grayscale tab (Camera Raw), 61, 
72–73

HUD color picker, 204

Hue/Saturation adjustments
applying, 238
for increasing saturation, 225
range, setting, 239
Targeted Adjustment tool, 238

I
Illustrator, Adobe

art, pasting into Photoshop, 266
art, path/shape creation from, 423
opening/placing Photoshop Layer 

into, 485
Photoshop to, 484

image assets
file formats, 489
generating, 490–493
scaling, 494
See also asset files

Image menu
Adjustments submenu

command effects, 222
HDR Toning command, 253
Replace Color command, 304

Canvas Size command, 140
Image Rotation commands, 103, 148
Image Size command, 256
Mode submenu, 3
Trim command, 146

Image Processor dialog, 488

Image Size dialog
Auto Resolution option, 138
downsampling for print size, 139
downsampling for Web output, 139
image resolution, changing for print 

output, 136
image upscaling for print output, 137
settings, restoring, 136

images
colors as building block of, 2
cropping, 141–143
downsampling, 139
flipping, 148
HDR, 250–253
for layer effects, 391
maximum size, 13
moving, in document window, 102
multichannel, 4
multiple, cropping, 144–146
PDF presentation of, 444–445
playing actions on, 429, 430–431
previews (Bridge), 29–32
print resolution, 13
repositioning, in document window, 

102
reshaping areas in, 313
resizing (Camera Raw), 60, 82
resolution, 136, 137
rotating, 148
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rotating (Camera Raw), 82
scaling (Camera Raw), 82
straightening, 147
tinting, 248–249
trimming areas around, 146
upscaling for print output, 137
Web resolution, 13

Import Options dialog, 485

importing
preset libraries, 132
type as Smart Object, 371
video files, 450

InDesign, Adobe
Photoshop to, 484
placing Photoshop layer into, 485

Indexed Color mode, 4

Info panel, 122

inkjet printing
outputting files for, 476–482
printer driver settings, 476–477
proofing documents for, 474
RGB Color mode for, 473

Inner Glow layer effect, 382

Inner Shadow layer effect, 382, 394

Insert Menu Item dialog, 434

Interface preferences, 99, 104, 112, 
460–461

illustrated, 461
Options, 460

inverting
layer masks, 191
selections, 175

Iris Blur filter
blurring control, 326
defined, 325
mask, using, 333
using, 328

isolating layers, 162

isolation mode, exiting, 163

J
JPEG files

Generator quality setting, 491–492
importing into Photoshop as 

embedded Smart Objects, 
265–266

opening, 33
opening into Camera Raw, 52–53
previously edited, opening (Camera 

Raw), 52
raw files versus (Camera Raw), 49, 51
saving, 20, 488

saving raw files as (Camera Raw), 
95–96

for Web and mobile device output, 
489

K
kerning type, 377

keyframes, 449, 455

Keyword preferences (Bridge), 472

keywords (Bridge), 38–39

Keywords panel (Bridge)
assigning keywords to files via, 39
creating keywords/subkeywords 

in, 38
defined, 26

L
Lab Color mode, 4

labels, thumbnail (Bridge), 40

Labels preferences (Bridge), 472

Lasso tool
defined, 114
in deselection, 170
in free-form selections, 169

launching
Bridge, 23
Photoshop, 1

Layer Comp Options dialog, 446

layer comps
alert icons, clearing, 448
applying layer edits to, 447–448
creating, 123, 446
defined, 123
deleting, 448
displaying, 446–447
duplicating, 446
PDF presentation of, 448
syncing edits to, 447–448
updating, 447

Layer Comps Options dialog, 123

Layer Comps panel
Delete Layer Comp button, 448
illustrated, 123
Last Document State listing, 447
New Layer Comp button, 446
Restore Last Document State 

command, 447
Update Layer Comp button, 447

Layer Comps to PDF dialog, 448

layer effects
applying, 389–390, 391
applying to adjustment layer, 385
Bevel, 392–393

copying, 398
default settings, 391
Drop Shadow, 382, 394–395
Emboss, 392–393
essentials, 389–391
flattening, 399
Gradient Overlay, 396–397
hiding/showing, 390
imagery selection, 391
Inner Glow, 382
Inner Shadow, 382, 394
live aspect of, 398
moving, 398
multiple, applying, 402–403
Outer Glow, 382, 404
Pattern Overlay, 397
Pillow Emboss, 393
rasterizing, 403
removing, 398
Satin, 397
scaling, 397
settings, changing, 390
settings, saving, 393
Stroke, 396
types of, 389

layer groups
asset generation, 492
in clipping mask, 344
creating, 154–155
deleting, 156
dragging up/down, 154
duplicating, 151
hiding/showing, 316
locking, 159
moving layers out of, 155
opacity, changing, 158
renaming, 152
selecting, 153, 262
ungrouping, 156

layer masks
adding via Layers panel, 190
adjustment, editing, 227
applying, 194
black versus white areas in, 278
blending exposures via, 278
color, changing, 191
converting vector masks to, 417
copying, 194
creating, 190
defined, 190
deleting, 194
density adjustment, 192
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disabling, 194
edges, refining, 193
editing, 191–193
editing on adjustment layers, 227
editing with Brush tool, 280
enabling, 194
feather adjustment, 192
gradients in, 279–280
loading, 194
moving, 194
outputting selections as, 190
repositioning, 193, 439
reshaping, 191
shortcuts for, 227
working with, 193–194

Layer Style dialog
Angle setting, 390
Bevel and Emboss, 392–393
Blending Options, 346–347
Contour presets, 390
Drop Shadow, 394–395
Gradient Overlay, 396–397
illustrated, 390
Inner Shadow, 394
for layer styles, 400
opening, 346, 389, 391
Pattern Overlay, 397
Stroke, 396

layer styles
applying, 400
copying, 401
creating, 130, 401
defined, 127
with Layer Styles dialog, 400
rasterizing, 403
removing, 400
saving, 401
scaling, 138

layers
aligning, with one another, 281
aligning, with Smart Guides, 157
asset generation, 492
blank, adding, 150
blending modes, 210, 345–347
blending options, 346
clipping masks, 343–344
color-coding, 159
content, repositioning, 193
converting to Smart Object, 264
copying and merging, 165
creating, 150–152
deleting, 156

desaturating, 240, 241
distributing, 281
document creation from, 262
drag-copying, between files (Layers 

panel), 262–263
drag-copying between files (Move 

tool), 260–261
dragging from inside, 260
duplicating, 151
edges, fading via gradient in layer 

mask, 279–280
editable type, 124, 370–371
editing in Camera Raw, 54
file formats that support, 360
file size and, 166
fill, 124, 211–213
Fill percentage, 399
filtering, 160–161
flattening, 166
flipping, 148
hiding, 149, 156
image, 124
image asset generation from, 

489–494
isolating, 162–163
locking, 159
merging, 164
moving out of groups, 155
multiple, selecting, 153
naming, 151
nontransparent areas, selecting, 167
nudging one pixel at a time, 157
opacity, changing, 158
opening in Camera Raw, 54
pixel selection conversion into, 151
releasing from isolation, 162
renaming, 150, 152
repositioning, 157
restacking, 154
rotating, 148
scaling, 262
screening back, 254
selecting, 153, 167
selecting, in document window, 262
shape, 124, 405–423
straightening, 147
visible, merging, 165
warping, 356
See also adjustment layers

Layers panel
Add Layer Mask button, 278, 279, 

284, 315, 368, 439

Add Layer Style menu, 389
Add Vector Mask button, 416
Advanced Blending badge, 347
Apply Layer Mask option, 194
Background, 149, 151, 152
blending modes, 210
Blending Options, 361
context menus, 155
Convert to Smart Object command, 

264
Create Fill/Adjustment Layer menu, 

211, 212, 222
Delete Layer button, 226, 398
Delete Layer Mask option, 194
Delete Vector Mask option, 194
display options, 159
drag-copying layers with, 262–263
Duplicate Layer command, 165
Fill setting, 399
Filter Type menu, 160, 163
Flatten Image command, 166
illustrated, 124
isolation mode, exiting, 163
Layer Filtering On/Off button, 160, 

163
layer mask creation with, 190
listings, filtering, 160–161
Lock Transparent Pixels button, 158, 

290, 302
Merge Down command, 226
Merge Layers command, 226
Merge Visible command, 165
New Group button, 155
New Group from Layers command, 

154
New Layer button, 150, 151
options, 159
selecting layers via, 153
thumbnail options, 159
uses, 124
Video Group listing, 455

leading, 378

Lens Correction filter, 441

Lens Corrections tab (Camera Raw)
defined, 80
edits, applying to multiple photos, 83
Manual settings, 81–83
for multiple photos, 83
preset corrections, 81
Profile settings, 80
using, 80–83
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Levels adjustment layer
illustrated effects, 230
mask, 385
screening back layers with, 254
settings, applying, 230
tonal values correction with, 230–231
See also adjustment layers

Light Table workspace (Bridge), 28

Lighten blending mode, 209, 316–317

Line tool, 115

linked Smart Objects
alert, missing, 35
converting to embedded, 274
creating, 272
editing contents of, 273
gathering copies of, 494
Layer Comps menu, 272
missing, getting data on, 274
relinking, 274
replacing, 271
updating, 274
working with, 273–275
See also Smart Objects

Liquify filter
applying to Smart Objects, 354
distortion tools, 352–354
edits, removing, 354
protecting image areas from, 352
quick access to tools, 354
Reconstruct Options, 354
for retouching, 313, 355
Tool Options, 352–353

locking
layers or layer groups, 159
transparent pixels, 158

loupe (Bridge), 31, 32, 341, 470

luminance (Camera Raw), 70–71

M
Mac OS

Application frame, 98
droplet usability in, 432
exiting Photoshop in, 22
launching Bridge in, 23
launching photoshop in, 1
Save As dialog box, 19
ZIP file creation, 488

Magic Eraser tool, 115

Magic Wand tool
defined, 114
using, 174–175

Magnetic Lasso tool, 114

masks
with Adjustment Brush tool (Camera 

Raw), 74–78
Blur Gallery filter, 333
clipping, 343–344
creating, 190
density, 192
edges, softening, 440
editing, 191–193
feathering, 192
layers, 190–194
options on Properties panel, 126, 

192–193
partial, 188
refining edges of, 193
storing selections as, 189
vignette creation via, 440
zooming in on, 188
See also filter masks; layer masks; 

Quick Masks; vector masks

Maximum filter, 364

Merge to HDR Pro dialog
Advanced tab, 250, 251
Curves tab, 252
in making images look surreal, 253
opening, 250
Tones and Detail, 250, 251
using, 250–252

merging
adjustment layers, 226
layers, 164
visible layers, 165

metadata (Bridge), 37

Metadata panel (Bridge)
assigning keywords to files via, 39
defined, 26

Metadata placard (Bridge), 29

Metadata preferences (Bridge), 471

midtones
adjusting separately, 347
auto correction of, 234–235
Color Balance adjustment, 237
color value selection, 234
darkening, 223, 224
with Levels adjustment, 230
lightening, 243, 254
reducing blue and green in, 245

Minimum filter, 364, 366

Missing Fonts dialog, 34

Missing Profile alert dialog, 35

Mixer Brush tool
Airbrush tip, 294

bristle brush creation, 296
bristle brush paint options, 297
cleaning bristle brushes, 297
defined, 114
Erodible tip, 294
photos into paintings, 298–300
using, 296–298

mobile devices, file format selection,
489

Monitor Color preset, 8

Motion panel, 453

Motion workspace, 449

Move tool
in adding isolated layers, 163
drag-copying with, 259, 260–261
in layer selection, 153
in moving selection contents, 171
Options bar, 257, 262, 281
in repositioning layer mask, 193
in repositioning layers, 157
scaling type with, 376
transformations with, 348–349

moving
with Content-Aware Move tool, 322
layer effects, 398
layer masks, 194
layers, Smart Guides and, 286
selection borders or contents, 171
vector masks, 416

N
Navigator panel

functions, 125
illustrated, 125
in repositioning, 102
in zooming, 102

New (document) dialog, 15–16

New Actions dialog, 428

New Crop Preset dialog, 145

New Document Preset dialog, 16

New Layer Comp dialog, 446

New Layer dialog, 152

New Preset dialog (Camera Raw), 92

New Snapshot dialog, 200

New Spot Channel dialog, 388

New Style dialog, 401

New Tool Preset dialog, 134

New Workspace dialog, 38, 108

noise reduction (Camera Raw), 50

North America Newspaper preset, 8

North America Web/Internet preset, 8
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North American General Purpose 2 
preset, 8

North American Prepress 2 preset, 7, 
8, 9, 10

Note tool, 114

O
opacity

blending layers, 345
brush, 290
changing, layer or layer group, 158
duplicate layer, 368
fill layer, 211–213
fill percentage, 399
overlay, 396, 397
shadow, 394
Smart Object, 363
stops, 214
tool, 209

Open as Smart Object dialog, 265

OpenGL, enabling, 97

OpenType characters, 379

optimized files, 488

Options bar
accessing, 110
Brush tool, 188, 191, 227, 290
Character panel, 373
Clone Source tool, 282
Clone Stamp tool, 318–319
Color Replacement tool, 306, 309
Content-Aware Move tool, 322
Content-Aware Scale command, 350
Crop tool, 141, 142, 146
Elliptical Marquee tool, 168, 439, 440
Eraser tool, 300
Eyedropper tool, 208
features, changing, 110
Free Transform command, 349
Freeform Pen tool, 415, 418
Gradient tool, 279
Healing Brush tool, 310
History Brush tool, 301–302
Horizontal Type tool, 370, 373, 376
Magic Wand tool, 174
Mixer Brush tool, 110, 296, 297, 298
Move tool, 153, 257, 262, 281
numerical values, changing, 123
Patch tool, 314, 324
Path Selection tool, 407, 412
Pen tool, 217, 415, 420, 421, 423, 424
Quick Selection tool, 172
Rectangular Marquee tool, 168
Red Eye tool, 309

Ruler tool, 288
Sharpen tool, 342
Spot Healing Brush tool, 313
Toggle Brush Panel button, 107
Tool Preset picker, 113
values, canceling, 110
Vertical Type tool, 370, 373, 376
Warp command, 356
Workspace menu, 104, 108, 109, 110

orientation, type, 378

Outer Glow layer effect, 382, 404

out-of-gamut alert, 206

P
Paint Bucket tool, 115

paintings
Texturizer filter and, 367
turning photos into, 298–300

panel
Actions, 116, 427–438
Adjustments, 117, 221–226
Brush, 117, 290–294
Brush Presets, 118, 295
Channels, 2–4, 118
Character, 119, 369, 371, 377–379
Character Styles, 119, 380, 383
Clone Source, 120, 282–283
Color, 120, 206
Histogram, 121, 228–229
History, 121, 195–202
Info, 122
Layer Comps, 123, 446–448
Layers, 124, 149–166, 262–264, 

278–279, 284
Motion, 453
Navigator, 102, 125
Paragraph, 125, 371, 380
Paragraph Styles, 125, 380, 383
Paths, 125, 418–419, 423–426
Properties, 126, 191, 194, 222–226
Styles, 127, 400–401
Swatches, 127, 207
Timeline, 127, 449
Tool Presets, 127
Tools, 113–116, 188
Transition, 452

panel groups
closing, 106
floating, 107
maximizing/minimizing, 106
moving, 107
reconfiguring, 106–107

panels
closing, 106
configuring, 105–107
deleting presets from, 130
hidden docks, displaying, 105
hiding, 105, 106
icons, 112
maximizing/minimizing, 106
moving, 107
opening, 105
preset management via, 130–132
redocking into Application frame, 107
restoring default presets to, 132
showing, 105, 106
widening or narrowing, 107

panels (Bridge)
Collections, 26
configuring manually, 36
Content, 26, 29, 37, 45
displaying/hiding, 36
Favorites, 26, 29
Filter, 26, 41
Folders, 26, 29
Keywords, 26, 38–39
Metadata, 26
Preview, 26, 29

panoramas, 284–285

PANTONE PLUS (+) colors, 205

Paragraph panel
alignment buttons, 380
controls, 380
East Asian Features, 371, 469
functions, 125
illustrated, 125
justification buttons, 380
Middle Eastern Features, 371, 469
South Asian features, 469

Paragraph Styles panel
Clear Overrides button, 381
functions, 125
illustrated, 125
Load Default Type Styles command, 

383
Load Paragraph Styles command, 383
New Paragraph Style button, 381
Redefine Paragraph Style by Merging 

Override button, 382
Save Default Type Styles command, 

383

paragraph type
converting to point type, 376
creating, 370
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transforming, 384

Paste Camera Raw Settings dialog, 93

Paste dialog, 266

pasting
files as Smart Objects, 266
Illustrator art into Photoshop, 266
refining selections after, 261
into selections, 258
selections, 256

Patch tool
defined, 114
removing image elements with, 324
retouching with, 314

Path Blur filter
applying, 330–331
blurring elimination, 331
mask, using, 333
strobe effect, 331

Path Selection tool
in aligning shapes, 413
defined, 115
Options bar, 407, 412
in uniting shapes, 413
with vector masks, 414, 417

paths
applying fill/stroke colors to, 426
combining, 425
copying, 425
creating from Illustrator, 423
creating from shape layer, 423
creating vector masks from, 414
curved, drawing, 421
deleting, 425
hiding/displaying, 419
loading as selection, 426
nonsmooth curve, drawing, 422
preserving, choosing file formats 

for, 425
producing shapes from, 423
repositioning, 419
selecting/deselecting, 419
storing and accessing, 125
straight-sided, drawing, 420
temporary (Work Paths), 418, 419
transforming, 425
working with, 425–426

Paths panel
Delete Path button, 425
Fill Path with Foreground button, 426
illustrated, 125
Load Path as Selection button, 425, 

426

Make Work Path from Selection 
button, 423, 425

path listings, restacking, 425
Stroke Path with Brush button, 426
working with, 418–419

Pattern Fill dialog, 217

Pattern fill layers, 213

Pattern Overlay layer effect, 397

Pattern picker, 292

Pattern Stamp tool, 114

patterns
custom, 217, 218
hiding areas of, 218
illustrated, 218
repositioning, 397
saving, 218
scaling, 397
scripted, 217–220

PDF format
in Photoshop feature preservation, 19
presentation of images, 444–445
presentation of layer comps, 448
saving files in, 486
selecting, 18

PDF Presentation dialog, 444–445

Pen tool
in adding/deleting points, 424
combining skills, 423
defined, 115
in drawing curved paths/shapes, 421
in drawing nonsmooth curves, 422
in drawing paths, 415
in drawing straight-sided paths/

shapes, 420

Pencil tool, 114

Performance preferences, 464–465
Graphics Processor Settings, 464
History & Cache, 196
illustrated, 465
Memory Usage, 464
Scratch Disks, 464
Use Graphics Processor, 97, 103, 289

perspective
problems, correcting, 144
transformation, 349

Perspective Crop tool, 114, 144

Photo Downloader (Bridge), 24–25

Photo Filter adjustments, 233

Photomerge dialog, 284–285

photos
downloading (Bridge), 24–25
sampling colors from, 298

shooting for HDR composite, 250
shooting for panorama, 284
turning into paintings, 298–300
turning into tinted drawing, 368

photos (Camera Raw)
archiving as DNG files, 95
cropping, 56
cycling through, 94
embedded Smart Object, editing, 

268
grayscale, color tint application, 79
lens correction synchronization, 83
opening into Camera Raw, 52
opening into photoshop, 95
preferences, setting, 52
resolution, 58, 60
rotating, 82
scaling, 82
sharpening, 58, 70
straightening, 57
stretching, 82
updating, 52
vignette application to, 85
workflow settings for, 60

Photoshop
exiting/quitting, 22
getting to quickly (Bridge), 33
launching, 1

Photoshop Import Options dialog, 485

pickers
deleting presets from, 130
loading presets onto, 131, 133
preset management via, 130–132
restoring default presets to, 132
saving presets on, 131
See also specific pickers

Pillow Emboss layer effect, 393

pixels
adding to canvas, 140
erasing, 300
maximum image size in, 13
outside canvas, 257
pasted, 256
rasterizing type into, 386–387
selection, turning into layer, 151
shadow, in histogram, 229
transparent, locking, 158

Place Along Path dialog, 219

Place dialog, 271, 484

Playback preferences (Bridge), 471

Plug-ins preferences, 468–469, 490
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PNG format
Generator quality setting, 491–492
for Web and mobile device output, 

489

point type
aligning, 370
converting to paragraph type, 376
creating, 370

Polygon tool, 115

Polygonal Lasso tool
defined, 114
in straight-sided selections, 169

pop-up sliders, 123

PostScript printing options, 480

preferences, 457–472
Cursors, 113, 313, 466
Experimental Features, 469
File Handling, 20, 52, 462–463
General, 101, 129, 255–256, 272, 405, 

458–459
Guides, Grid & Slices, 286, 468
Interface, 99, 104, 112, 460–461
opening, 457
Performance, 97, 103, 196, 289, 

464–465
Plug-ins, 468–469, 490
resetting, 457
Sync Settings, 461, 495–496
syncing via Creative Cloud, 457
Transparency & Gamut, 158, 466
Type, 371, 469
Units & Rulers, 16, 467

preferences (Bridge), 470–472
Advanced, 472
Cache, 48, 472
Camera Raw, 52
File Type Associations, 472
General, 52, 470
Keywords, 472
Labels, 472
Metadata, 471
opening, 457
Playback, 471
resetting, 457
Startup Scripts, 472
Thumbnails, 37, 471

preferences (Camera Raw), 52

preset libraries
exporting, 132
importing, 132
loading, 131
saving presets as, 131

Preset Manager
illustrated, 133
loading presets with, 133
opening, 133, 295
saving presets with, 133

presets
adjustment layer, 226
brush, 128, 295
Color Range, 177
color settings, 7
creating, 16
creation of, 130
default, restoring, 132
deleting, 16, 130, 133
document, 16
exporting, 132
gradient, 214
importing, 132
loading, 133
naming, 16
renaming, 133
saving, 16, 133
tools, 134
unsaved, storage, 130

presets (Camera Raw)
applying, 92
saving settings as, 92

Presets tab (Camera Raw), 61

Preview panel (Bridge)
defined, 26
image display in, 29

Preview workspace (Bridge), 28

previews (Bridge)
comparing, 30
full-screen, 30
quality options, 30
in Review mode, 32
thumbnail, 29

previews (Camera Raw)
histogram clipping warnings, 64
positions, swapping, 61
raw photos, 50
Threshold, 66
zooming in, 55

previews (filter), 358, 359

Print dialog
accessing, 476
Color Management settings, 478, 

481, 482
illustrated, 479
PostScript Options category, 480
printer driver settings, 476–477

Printing Marks options, 480
settings, 478–480

print output
commercial, 475, 483
downsampling photos for, 139
file resolution, 14, 16, 136
quasi hard proof, 480
scaling, 478
soft proofing for, 474–475
upscaling images for, 137

printers
color management, turning off and, 

481–482
driver settings, 476–477
profiles, acquiring, 11
rendering intents and, 475

process colors, 205

profiles
color, 5, 12
document, 21
printer, 11

proofing colors
for commercial printing, 475
for inkjet output, 474
for Web output, 475

Properties panel
adjustment layer options, 126
Apply Mask button, 194
Auto-Select Parameter option, 225
Black & White controls, 246, 247, 248
Brightness/Contrast controls, 232
Clip to Layer button, 225
Color Balance settings, 236, 237
Curves Display Options, 242
Delete Adjustment Layer button, 226
Delete Mask button, 194
Gradient Map controls, 248, 249
Hue/Saturation controls, 238, 308
illustrated, 126
Invert button, 191
Levels controls, 230, 254
Linked Smart Object controls, 272, 

273
Live Shape Properties button, 407
Load Selection from Mask button, 194
Mask Edge option, 193
mask options, 126
Photo Filter controls, 233
settings, 222–226
Vibrance controls, 239, 240

Properties/Print dialog, 476, 477

ProPhoto RGB color space, 8
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PSB files
in Photoshop feature preservation, 19
selecting, 18
working with, 20

PSD format
in Photoshop feature preservation, 19
saving files in, 488
saving raw files in (Camera Raw), 

95–96
selecting, 18

Q
Quick Mask Options dialog, 189

Quick Masks
creating selections via, 189
in reshaping selections, 188
in whitening teeth or eyes, 308

Quick Selection tool
defined, 114
using, 172–173

R
Radial Filter tool (Camera Raw)

darkening photo areas with, 88–89
defined, 88
mask, editing with a brush, 86

RAM, 21

rasterizing
layer effects, 403
layer styles, 403
Smart Objects, 271
type, 386–387

ratings, thumbnail (Bridge), 40

raw files (Camera Raw)
advantages to using, 49–51
copy, opening, 95
JPEG files versus, 49, 51
opening into Camera Raw, 52, 53
opening into photoshop, 95
previewing, 50
saving, 95
TIFF files versus, 49, 51
See also Camera Raw

Record Stop dialog, 433

Rectangle tool, 115

Rectangular Marquee tool
in creating selections, 168
defined, 114
in deselection, 170
in fixed ratio/dimensions selection, 

168
in frame-shaped selections, 179

Red Eye Removal tool (Camera Raw), 
55, 309

Red Eye tool
defined, 114
using, 309

Refine Edge dialog
accessing, 182
in artistic border creation, 442
Decontaminate Colors option, 186, 

187
illustrated, 183
layer mask creation with, 190
Output To menu, 442
Refine Radius tool, 186
refining hair selection with, 184–187
refining selection edges with, 

182–183
Smart Radius option, 184

Refine Mask dialog, 193

Refine menu (Bridge), 32

refocusing. See Blur Gallery

Render Video dialog, 456

rendering intents, 475, 478

Replace Color dialog, 304–305

Replace Contents command, 271

resampling files, 135

reshaping
bounding box, 384
with Content-Aware Move tool, 322
images, 313
layer masks, 191
with Liquify filter, 352–355
selections, 188
shadows, 395
with Warp command, 356

resolution
auto, 138
calculating, 13–14
default values, setting, 16
document, 135–139
image, 135–136
methods of setting, 14
photos (Camera Raw), 58, 60
print output, 14, 16, 136
selecting, 15
Web output, 13, 16

retina displays, zoom and, 101

retouching
by cloning imagery, 318–319
Color Replacement tool, 306–307
eye whitening, 308
Gaussian Blur filter, 316–317

guidelines, 303
Healing Brush tool, 310–312
Liquify filter, 313, 355
Patch tool, 314, 324
Red Eye tool, 309
Replace Color command, 304–305
skin smoothing, 315
Spot Healing Brush tool, 313
Surface Blur filter, 315
teeth whitening, 308

Revert Construction dialog, 354

reverting, to last saved document 
version, 18

Review mode (Bridge)
previewing images in, 32
rating thumbnails in, 40

RGB Color mode
channels, 3
defined, 3, 4
for inkjet printing, 473
for Photoshop work, 221

RGB color model
choosing, 206
in color selection, 204
defined, 2, 206

Rotate View tool, 103, 116

rotating
bounding box, 384
clone source overlay, 283
images (Camera Raw), 82
items, 349
layers, 148

Rounded Rectangle tool, 115

ruler guides
attributes, changing, 287
creating, at specific location, 288
creating by dragging, 287
locking/unlocking, 288
relocating, 287
removing, 288
showing, 287

Ruler tool
defined, 114
in measuring distance or angle 

with, 288
straightening layers with, 147

rulers
origin, changing, 287
showing and hiding, 287
units, changing, 287
units, in actions, 428
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S
Satin layer effect, 397

saturation adjustments
Basic tab (Camera Raw), 67
Color Replacement tool, 306–307
Hue/Saturation, 225
vibrance, 239–241
in whitening teeth, 308

Save Adobe PDF dialog, 445, 486

Save As dialog, 18, 19, 20, 483

Save As Web dialog, 139

Save dialog, 131

Save Options dialog, 95–96

Save Settings dialog (Camera Raw), 92

saving
action sets, 438
adjustment presets, 226
Brush Presets panel brushes, 131
brushes, 295
Camera Raw settings as preset, 92
color settings, 11
custom workspaces, 108–109
document presets, 16
documents, 18–20
files (Camera Raw), 94
files, in JPEG format, 488
files, in PDF format, 486
files, in PSD format, 488
files, in TIFF format, 487, 488
flattened documents, 166
layer effect settings, 393
layer styles, 401
multiple files, 488
patterns, 218
presets, 133
previously saved documents, 18
workspaces (Bridge), 38

scaling
based on percentages, 350
clone source overlay, 283
Content-Aware, 350–351
gradients, 397
image assets, 494
images (Camera Raw), 82
items, 348
layer effects, 397
layers, 262
patterns, 397
print output, 478
Smart Objects, 266, 267
styles, 138
type, 376

Screen mode menu, 104, 105

screening back type, 385

scripted patterns, 217–220

scrolling, in multiple document 
windows, 103

scrubby sliders, 123

searching for files (Bridge), 45

Select menu
Active Layers command, 410
All command, 167
Color Range command, 176
Deselect command, 170
Deselect Layers command, 382
Focus Area command, 180–181
Grow command, 175
Inverse command, 175
Isolate Layers command, 162
Reselect command, 170
Similar command, 175
Transform Selection command, 348

selection edges
adjusting, 257
feathering, 259
refining, 183–187

selections
adding to via command, 175
in adjustment layers, 222
anchor points on shapes, 411
border, moving, 171
border, showing/hiding, 178, 324
canvas area of a layer, 167
of colors, 176–178
contents, moving, 171
creating paths from, 423
creating via Quick Mask, 189
creating with Color Range command, 

176–178
in defining crop boxes, 145
deleting, 170
deselecting, 170
drag-copying, between files (Move 

tool), 260–261
drag-copying, on same layer, 259
Elliptical Marquee tool, 168, 179
enlarging, 172
expanding, 175
filling, 170
in-focus areas, 180–181
frame-shaped, 179
free-form, 169
hair, 184–187
inverting, 175

Lasso tool, 169
layer-based, 153
loading, 182
loading layer masks as, 194
loading paths as, 426
loading shape layers as, 409
nontransparent areas of layer, 167
pasting into, 258
Polygonal Lasso tool, 169
Quick Selection tool, 172–173
Rectangular Marquee tool, 168, 179
reselecting, 170
reshaping, 188
saving, 182
shape layer path, 410–411
shrinking, 172
storing as masks, 189
straight-sided, 169
transforming, 348–349
type, 372
vector tool, 169

Settings menu (Camera Raw)
restoring settings via, 62
saving settings as presets with, 92

shadows
auto correction, 234–235
Brightness/Contrast adjustment, 232
clipping, removing (Camera Raw), 66
Color Balance adjustment, 236
Curves adjustment, 242–243
drop (layer effect), 394–395
HDR images, 250–253
Levels adjustment, 230
pixels in histogram, 229
softening, 335
tinting (Camera Raw), 79

Shake Reduction filter
applying, 339–342
blur trace path, creating/adjusting, 

340–341
blur trace regions, creating, 340
defined, 339
edge noise, reducing, 340
settings, saving, 342
settings, selecting, 339
settings comparison/adjustment in 

a loupe, 341

shape layers
adding shapes to, 413
aligning shapes within, 413
anchor points selection, 411
attributes, changing, 407–409
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combining into one layer, 413
creating from presets, 219
creating paths from, 423
creating vector masks from, 414
creating with shape tools, 406
defined, 124
de-isolating, 412
excluding shapes in, 413
intersecting shapes in, 413
isolating, 412
loading as selection, 409
merging, 164
paths, selecting, 410–411
properties, changing, 407–408
properties, copying, 409
subtracting shapes in, 413
uniting shapes in, 413
warp settings, 356
See also vector objects

Shape Name dialog, 423

Sharpen tool
defined, 115
using, 342

sharpening
Camera Raw, 50
photos (Camera Raw), 58, 70
Shake Reduction filter, 339–342
Sharpen tool, 115, 342
Smart Sharpen filter, 334–336
Unsharp Mask filter, 337–338

shortcuts
layer mask, 227
tool setting changes, 129
transform, 349
undo, 111
zoom, 101

Single Column Marquee tool, 114, 168

Single Row Marquee tool, 114, 168

Single-Line Composer, 380

16-bit files, 17

skewing items, 349

skin smoothing
with Gaussian Blur filter, 316–317
with Surface Blur filter, 315

Slice Select tool, 114

Slice tool, 114

Smart collections (Bridge), 46

Smart Filters
applying, 360
blending options, editing, 361
copying, 361
deleting, 362

editing, 360
example use, 363–364
hiding/showing effects, 361
mask, 362
restacking, 361

Smart Guides
aligning layer content with, 157
in moving or copying layers, 286
transformations with, 348

Smart Objects
applying filters to, 360–367
converting, 274
copies, converting into layer, 271
copying, 269
defined, 264
duplicating, 269
embedded

converting layers in 
Photoshop files to, 264

converting to linked, 274
creating, 264–267
duplicates, creating, 269
duplicates, editing, 269–270
editing, 268–270
opening files as, 265
opening files from Camera 

Raw as, 265
pasting Adobe Illustrator 

art as, 266
placing/dragging files as, 266–267
replacing, 271

importing type as, 371
in lieu of merge or flatten, 164
linked

converting to embedded, 274
creating, 272
editing contents of, 273
missing, alert for, 35
missing, getting data on, 274
relinking, 274
replacing, 271
updating, 274
working with, 273–275

merging, 164
Missing and Changed list, 21
opacity, 363
rasterizing, 271
replacing, 271
thumbnails, 269, 270, 271

Smart Quotes, 371

Smart Sharpen filter, 334–336

Smudge tool, 115

Snap To feature, 288

snapshots
creation of, 199
deleting, 201
document creation from, 202
of history state, 200
naming, 200
as newest history state, 201
options, 199
using, 199–201

Snapshots tab (Camera Raw), 61, 92

soft proofs
commercial printing, 475
defined, 473
inkjet, 474

Solid Color fill layers, 184, 211

Spatter filter, 403

Spin blur filter
blurring control, 326
defined, 325
mask, using, 333
strobe effect, 331
using, 331

Split Toning tab (Camera Raw), 61, 79

splitting video clips, 452

Sponge tool, 115

spot colors
channel, putting type in, 388
choosing, 205
for color accuracy, 204
defined, 204
separation into process colors, 205

Spot Healing Brush tool
Content-Aware option, 313, 320
defined, 114
using, 313

Spot Removal tool (Camera Raw), 55, 
90–91

spring-loading tools, 113

sRGB IEC61966-2.1 color space, 8

standard collections (Bridge), 46, 47

Standard screen mode, 104

Startup Scripts preferences (Bridge), 
472

Status bar, 21

Straighten tool (Camera Raw), 55, 57

straightening
images, 147
layers, 147
photos (Camera Raw), 57

strobe-and-flash effect, 331
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stroke, shape layer
copying, 409
restyling, 408
settings, saving, 408

Stroke layer effect, 396

styles. See layer styles

Styles panel
Clear Style button, 400
illustrated, 127
New Style button, 401
saving styles to, 401
uses, 127

Surface Blur filter, 315

SVG format, for Web and mobile 
device output, 489

swatches, color
creating, 207
current, using, 207
default, restoring, 207
loading, 207
predefined, 127
text, 373
user-defined, 127

Swatches panel
adding color to, 207
choosing color via, 207
illustrated, 127
Load Swatches command, 207
New Swatch of Foreground Color 

button, 130, 207
Replace Swatches command, 207

Sync Settings preferences, 461, 
495–496

Synchronize dialog (Camera Raw), 94

synchronizing
Camera Raw settings, 94
color settings, 9
lens correction (Camera Raw), 83
presets, 130

T
Targeted Adjustment tool

auto-selecting, 246
Black & White adjustment layer, 246
Curves adjustment layer, 242, 244
Hue/Saturation adjustment, 238

Targeted Adjustment tool (Camera 
Raw), 68–69, 73

teeth whitening, 308

textures, grain (Camera Raw), 84

Texturizer filter, 367

3D Material Drop tool, 115

3D Material Eyedropper tool, 114

Thumbnail preferences (Bridge), 37, 
471

thumbnails (Bridge)
adding to collections, 47
adding to stacks, 43
badge, 52
cycling through, 29
displaying, 29
filtering, 41
full-screen preview of, 30
grouping into stacks, 42
labeling, 32, 40
last sequence, restoring, 41
multiple, selecting, 29
numbers, 29
previewing, 29–30
quality options, 30
rating, 32, 40
rearranging, 41
rearranging within stacks, 42
removing from collections, 47
removing from stacks, 43
removing ratings/labels from, 40
resizing, 36
selecting, 29
selecting in stacks, 42
sorting, 41
stacks, 42–43

TIFF files
in feature preservation, 18
opening (Bridge), 33
opening in Camera Raw, 52
raw files versus (Camera Raw), 51
saving, 487
saving multiple files as, 488
saving raw files as (Camera Raw), 

95–96

TIFF Options dialog, 487

Tilt-Shift filter
blurring control, 326
defined, 325
mask, using, 333
in photography, 329
using, 329

timeline
adding tracks to, 450
defined, 449

Timeline panel
Add Media menu, 450, 453
Add Media to Track button, 450
Audio panel access, 456

Enable Keyframe Animation button, 
455

illustrated, 127, 449
Motion panel access, 453
Mute Audio Playback button, 451
New Video Group option, 450
opening, 449
Play button, 451
Render Video button, 456
Split at Playhead button, 452
Transition button, 452
uses, 127
in video editing, 449
Video panel access, 451
See also video; video clips

tints
applying to grayscale photo, 79
Black & White adjustment, 246, 248
Gradient Map adjustment, 248–249

title clips, 453

tonal adjustments
Basic tab (Camera Raw), 63–67
Black & White adjustment, 246–248
Brightness/Contrast adjustment, 232
Curves adjustment, 242–243
display calibration and, 221
Levels adjustment, 230–231
redistribution (Camera Raw), 50
Tone Curve tab (Camera Raw), 68–69
vignette creation via, 440

Tone Curve tab (Camera Raw)
defined, 61
using, 68–69

Tool Preset picker, 113, 134

tool presets
creating, 130, 134
Crop tool, saving as, 145
default, restoring, 134
defined, 127
setting storage, 295
suggestions for, 134

Tool Presets panel, 127, 295

tool tips
metadata in, 37
preferences, 460
using, 112

tools
Add Anchor, 115
Art History, 115
Background Eraser, 115
Blur, 115
Brush, 114, 129, 289–294
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Burn, 115
Clone Stamp, 114, 318–319
Color Replacement, 114, 308
Color Sampler, 114
Content-Aware Move, 114, 322–323
Convert Point, 115
Count, 114
Crop, 114, 141–142, 144–146
Custom Shape, 115, 406
Delete Anchor, 115
Direct Selection, 115, 424
Dodge, 115
Ellipse, 115
Elliptical Marquee, 114, 168, 439
Elliptical Marquee tool, 179
Eraser, 115, 300
Eyedropper, 114, 208
Freeform Pen, 115, 418
Gradient, 115, 214, 279
Hand, 102, 116
Healing Brush, 114, 310–312
hidden, selecting, 113
hints, 113
History Brush, 115, 121, 301–302
Horizontal Type, 115, 370
Horizontal Type Mask, 115
Lasso, 114, 169
Line, 115
Magic Eraser, 115
Magic Wand, 114, 174–175
Magnetic Lasso, 114
Mixer Brush, 110, 114, 296–298
Move, 153, 171, 193, 257, 259, 

260–261, 262, 348–349
Note, 114
opacity, 209
Option bar settings, 113
Paint Bucket, 115
Patch, 114, 314, 324
Path Selection, 115, 407, 413, 417
Pattern Stamp, 114
Pen, 115, 420–422
Pencil, 114
Perspective Crop, 114
Polygon, 115
Polygonal Lasso, 114, 169
Quick Selection, 114, 172–173
Rectangle, 115
Rectangular Marquee, 114, 168, 442
Rectangular Marquee tool, 179
Red Eye, 114, 309
Rotate View, 103, 116
Rounded Rectangle, 115

Ruler, 114, 147, 288
selecting, 113
Sharpen, 115, 342
shortcuts for changing settings, 129
Single Column Marquee, 114, 168
Single Row Marquee, 114, 168
Slice, 114
Slice Select, 114
Smudge, 115
Sponge, 115
Spot Healing Brush, 114, 313
spring-loading, 113
Targeted Adjustment, 238, 242, 244, 

246
3D Material Drop, 115
3D Material Eyedropper, 114
Vertical Type, 115, 370
Vertical Type Mask, 115
Zoom, 101, 103, 116

tools (Camera Raw)
Adjustment Brush tool, 55, 73–78
Crop tool, 55, 56
Graduated Filter tool, 55, 86–87
Radial Filter tool, 88–89
Red Eye Removal tool, 55
Spot Removal tool, 55, 90–91
Straighten tool, 55, 57
Targeted Adjustment tool, 68–69, 73
types of, 55
White Balance tool, 55

Tools menu (Bridge)
Batch Rename command, 44
Cache command, 48
Photoshop submenu

Batch command, 429
Contact Sheet II command, 445
Image Processor command, 488
Load Files into Photoshop 

Layers command, 264
Merge to HDR Pro command, 250
Photomerge command, 284
Process Collections command, 284

Tools panel
Change Screen Mode option, 116
cycling through tools on, 113
Edit in Quick Mask Mode option, 116, 

188, 189
Edit in Standard Mode button, 188
illustrated, 114–116
Screen Mode menu, 104, 105
using, 113
See also tools

TOYO Color Finder, 205

tracking type, 377

tracks, video
adding to timeline, 450
applying adjustment layer to, 454
audio, 456
deleting, 451
See also video

transformations
applying, 348–349
Drop Shadow layer effect, 395
with Free Transform command, 

348–349
with Move tool, 348–349
paragraph type, 384
path, 425
selection border, 171
shortcuts, 349
with Smart Guides, 348
type, 376, 384
via Options bar, 349

Transition panel, 452

transitions, video
adding, 452
defined, 449
duration, adjusting, 452
See also video

Transparency & Gamut preferences,
158, 466

Trim command, 146

TRUMATCH color system, 205

type
aligning, 370, 380
anti-aliasing, 371
attributes, changing, 372
baseline shift, 379
converting, point/paragraph, 376
deleting, 372
editable, 369, 370
editing, 372
editing mode, exiting, 372
embossed leather, 404
fading, 378
font family/style, changing, 373
font size, changing, 376
formatting, 381–383
hyphenation, 380
importing as Smart Object, 371
justifying, 380
kerning, 377
leading, 378
orientation, 378
paragraph, 370, 376, 384
paragraph settings, 380
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point, 370, 376
rasterizing, 386–387
recoloring, 373
repositioning, on image, 385
scaling, 376
screening back layers with, 385
selecting, 372
special characters, 379
in spot color channel, 388
tracking, 377
transforming, 376, 384
warp settings, 356

Type preferences, 371, 469

type styles
applying, 381
copying between documents, 383
creating, 381
default, creating and loading, 383
editing, 382
formatting type with, 381–383
loading between documents, 383
overrides, clearing, 382

Typekit
fonts, downloading, 374–375
fonts, previewing, 374
missing font substitution, 34
turning on, 374
using, 374–375

Typekit.com, 374–375

U
undo shortcuts, 111

Units & Rulers preferences, 16, 467

Unsharp Mask filter
applying, 337–338
suggested settings, 337
variables, 337

V
vector masks

applying to its layer, 194
converting to layer masks, 417
copying, 416
creating by drawing path, 415
creating from existing path, 414
creating from shape layer, 414
creating from type, 416
deleting, 194
density adjustment, 192
disabling or deleting, 416
feather adjustment, 192
function, switching, 417
moving, 416

repositioning, 417
working with, 415–417

vector objects
aligning, 405
anchor points, adding/deleting, 

424–425
creating, 406
defined, 405
points, converting, 424
reshaping, 424–425
saving as custom shape, 423
segments, reshaping, 424

Vertical Type Mask tool, 115

Vertical Type tool
in changing font size, 376
creating type with, 370–371
defined, 115
recoloring type with, 373
selecting type with, 372

Vibrance adjustments, 239–241

video
adding still images to, 453
adjustment layer application to, 453
audio clips, 456
files, importing, 450
filter application to, 455
frames, 449
keyframes, 449
manual fade, 455
picture-in-a-picture, 455
playing, 451
rendering clips, 456
reviewing, 451
terminology, 449
timeline, 449, 450
title clips, 453
tracks, 449, 450, 451
transitions, 449
workspace setup for editing, 449

video clips
adding transitions to, 452
applying adjustment layer to, 454
applying filters to, 455
defined, 449
deleting, 451
length specification, 451
order, changing, 451
rendering, 456
speed setting, changing, 455
speed specification, 451
splitting, 452
title, 453

trimming by dragging, 451

View menu
Clear Guides command, 288
Extras command, 286, 348
Lock Guides command, 288
New Guide command, 288
Proof Colors command, 474, 475
Proof Setup command, 213, 474
Rulers command, 287
Show submenu, 157, 178, 286, 287, 

288
Snap command, 287, 288
Snap To submenu, 143, 171, 288

vignettes
creating via Lens Correction filter, 441
creating via tonal adjustment, 440
recording actions that apply, 431
white-bordered, creating, 439

vignettes (Camera Raw)
applying with Effects tab, 85
correcting in Manual tab, 81–83
correcting in Profile tab, 80

W
Warp command, 356

Warp Text dialog, 354

watermarks, 444

Web output
aligning vector objects for, 405
buttons for, 409
downsampling images for, 139
file format selection for, 489
resolution and dimensions for, 13, 16

white balance
adjustments, applying (Camera 

Raw), 63
setting (Camera Raw), 62

White Balance tool (Camera Raw), 55

white point, calibration, 6

Window menu
Arrange submenu, 99, 100, 102, 256, 

262
Brush Presets command, 295
Channels command, 2
Character command, 372
Options command, 110, 113, 128
Workspace submenu, 104, 449

Windows
droplet usability in, 432
exiting Photoshop in, 22
launching Bridge in, 23
launching photoshop in, 1
Save As dialog box, 19



520 Index

ZIP file creation, 488

Work Paths, 418, 419

Workflow Options dialog (Camera Raw)
Depth menu, 58
Intent options, 58
Open in Photoshop as Smart Objects 

option, 58
Preset menu, 58
presets, 58–59, 60
Resize to Fit menu, 60
settings, choosing, 58–59, 95
Simulate Paper & Ink option, 58
Space menu, 58, 59

working spaces
CMYK, 483
current, assigning, 12
settings, 8

Workspace menu (Options bar), 104, 
108, 109, 110

workspaces
choosing, 104

deleting, 109
non-user-defined, resetting, 109
resetting, 109
saving, 108–109
setting up for video editing, 449

workspaces (Bridge)
changing, 28
choosing, 28
custom, 38
default, 26
deleting, 38
Essentials, 28
Filmstrip, 28
Light Table, 28
order, changing, 28
predefined, restoring, 38
Preview, 28
resetting, 38
saving, 38

wrinkle removal, 310, 311, 314

Z
ZIP files, 488

zoom
level, changing, 101–103
level, changing via Navigator panel, 

102
level, changing with Zoom 

tool, 101
level, matching in multiple 

documents, 102
in multiple document 

windows, 103
retina displays and, 101
shortcuts, 101

Zoom tool
defined, 116
Scrubby Zoom, 101
Zoom All Windows option, 103
zoom level changes with, 101

Photography credits
Shutterstock.com
Photographs on the following pages are © ShutterStock.com: 1, 22, 
40, 45, 56, 57, 63, 68, 74, 77, 81, 84, 85, 88, 90, 97, 100, 103, 104, 135, 
136, 137, 140, 141, 142, 143, 148, 150, 151, 160, 167, 168, 169, 170, 
171, 172, 174, 175, 176, 178, 179, 180, 183, 184, 188, 189, 195, 200, 
201, 204, 208, 209, 211, 212, 222, 227, 230, 232, 233, 234, 236, 238, 
239, 240, 241, 242, 248, 256, 258, 259, 263, 267, 268, 269, 276, 280, 
282, 298, 301, 304, 310, 312, 313, 314, 315, 316, 318, 321, 322, 323, 
324, 327, 328, 329, 330, 334, 337, 342, 343, 351, 352, 355, 356, 361, 
365, 366, 367, 391, 394, 398, 404, 406, 414, 415, 417, 420, 437, 441, 
442, 443, 445, 457 

Gettyimages.com
Pages 14, 307, 348, 357, 384

Other photographs
Page 25 Rob Knight © Rob Knight Photography

All other photographs © Elaine Weinmann and Peter Lourekas


	Contents
	4: Camera Raw Why use Camera Raw?
	Opening photos into Camera Raw
	The Camera Raw tools
	Cropping and straightening photos
	Choosing default workflow options
	Using the Camera Raw tabs
	Using the Basic tab
	Using the Tone Curve tab
	Using the Detail tab
	Using the HSL/Grayscale tab
	Using the Adjustment Brush tool
	Using the Split Toning tab
	Using the Lens Corrections tab
	Using the Effects tab
	Using the Graduated Filter tool
	Using the Radial Filter tool
	Using the Spot Removal tool
	Saving and applying Camera Raw settings
	Synchronizing Camera Raw settings
	Converting, opening, and saving Camera Raw files

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Z




